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N. Parts

1 Cover
2 Base
3 Indicator lights (LED)
7 Closing screw (parked position) 
8 Base mounting holes (4)
9 Cover hinge
10 Antenna cable hole
11 2700 mAh recha rgeable bat tery (optional): versions

with housing only
12 Wall tamper device
13 Hole for wall tamper device fixing
14 SIM holder
15 PC-LINK connector
16 Programming jumpers: see “Description of jumpers” on

page 8
17 USB port: versions with housing only
18 Tamper contact
19 Terminal boards

20 Electronic board locator pins
21 JP2 current draw limiter jumper: see “Description of jump-

ers” on page 8
22 Battery connector: versions with housing only
23 ANT5-02 adapter cable
24 Adapter cable nut
25 Integrated antenna: versions with housing only
26 Hole for antenna cable on metal bracket
27 Metal bracket
28 ANT5-02, GSM antenna with 2 m cable and SMA

connector (optional)
29 GSM antenna with 2 m cable and MMC connector
30 Electronic board mounting holes (4)

N. Parts
Figure 1 – Identification of parts: version with housing.
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Figure 2 – Identification of parts: a) ANT5-02, GSM antenna with 2 m cable and SMA connector (optional); b) version with
housing; c) kit version.
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Hereby Digital Security Controls declares that
4005 Series

is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.
The complete Declaration of Conformity for each Device can be found at www.dsc.com.

The GS4005, GS4005-K, 3G4005/EU and 3G4005-K/EU product models have been certified by IMQ/A to be compliant with standards:
EN 50136-1:2012 and EN 50136 2:2013 for Alarm transmission system performance SP2 (D2, M2, T2, S0, I0) for vocal/SMS alarm messages and SP4 (D3, 

M3, T4, S2, I3) for digital messages;
EN 50131-10, Security Grading 2;

T031.
 To ensure conformity with the T031 standard, the Communicator must be connected to the panel with terminals LI and the following events and messages/

codes must be set: INTRUSION ALARM, TAMPER ALARM, MAIN POWER FAILURE, BATTERY FAILURE, HOLD-UP, ARMING, DISARMING, 
INHIBITED ZONE AND ISOLATED ZONE.

The communicator is certified IMQ-SECURITY SYSTEMS if powered by the panel and without backup battery.
Installation of these systems must be carried out strictly in accordance with the instructions described in this manual and in compliance with the local laws 
and bylaws in force. The above mentioned 4005 series is been designed and made to the highest standards of quality and performance. The manufacturer 

recommends that the installed system should be completely tested at least once a month. Digital Security Controls shall not be responsible for damage arising 
from improper installation or maintenance by unauthorized personnel. Digital Security Controls reserves the right to change the technical specifications of 

this product without prior notice.
RECYCLING INFORMATION

Digital Security Controls recommends that customers dispose of their used equipments (panels, detectors, sirens, and other devices) in an environmentally 
sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials. For specific information 

see www.dsc.com.

WASTE ELECTRICAL AND ELECTRONIC EQUIPMENT (WEEE) DIRECTIVE

To program the device, use software DLS 5 ver. 1.50 or later.

In the European Union, this label indicates that this product should NOT be disposed of with household waste. It should be deposited at an appropriate 
facility to enable recovery and recycling. For specific information see www.dsc.com.
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INTRODUCTION

The devices made by 4005 Series are GSM communicators which, if no PSTN line is available, send voice and digital alarms by
Quad-Band GPRS (HSPA Dual-Band) to Sur-Gard System I, II, III, IV and 5 receivers. The following versions are available.

 GS4005: communicator board with 2G module in plastic housing.
 3G4005-LAT: communicator board with 850/1900 MHz 3G module in plastic housing.
 3G4005/EU: communicator board with 900/1800 MHz 3G module in plastic housing.
 GS4005-K: kit including communicator board with 2G module, antenna with 2 m cable, adapter and metal bracket. 
 3G4005K-LAT: kit including communicator board with 850/1900 MHz 3G module, antenna with 2 m cable, adapter and metal

bracket.
 3G4005-K/EU: kit including communicator board with 900/1800 MHz 3G module, antenna with 2 m cable, adapter and metal

bracket.

Information relat ing to specific models is high lighted with reference to the respective code. The t erm “communicator” refers to
functions shared by all version s. This ma nual prov ides instructions for programming and using the communicator. For sp ecial
installation requirements, a remote outdoors antenna ANT5-15 with 15 m cable is available.

 The communicator may be installed by a qualified technician only and used on in areas with at most Pollution Level 2,
Overvoltage Category II, indoors in a non-danger zone. These instructions must be used in areas together with the panel's
installation manual. Follow all instructions given in this manual to the letter.
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General specifications

 Simulates a PSTN line.
 Detects the absence of a PSTN line and automatically switches to GSM.
 Manages and reports incoming and outgoing phone calls.
 GSM signal strength indicator.
 6 terminals, programmable as Open-Collector outputs or input lines.
 Protection against overvoltage on the phone line.
 2G Qua d band  (G S4005 and  GS4 005-K) or 3G, Dual Band (3G4005-LAT, 3G 4005/EU, 3 G4005K-LAT and 3G4005-K/EU)

communicator.
 Integrated antenna: versions with housing only.
 External antenna with magnetic base: kit versions only.
 SMS dialer.
 Voice dialer.
 Contact ID and SIA protocol decoding.
 Event transmission (audio/digital channel) to Sur-Gard System I, II, III, IV and 5 receivers.
 Options programmable by PC.
 32 SMS messages, each at most 70 characters long (2 for each input line plus 18 for status messages and 1 periodic).
 8 programmable phone numbers (max. 16 digits) for the SMS dialer.
 8 programmable phone numbers for transmitting events to Sur-Gard receivers.
 Up to 32 programmable phone numbers (max. 16 digits) for remote output activation.
 Remote output activation via call recognition, or SMS.
 Residual credit monitoring for prepaid SIM cards.
 (PTM) Panel Transmission Monitoring
 Integrated tamper switches.
 PC-LINK port.
 Type A USB connector (Host and device): versions with housing only.
 Programming with USB key: versions with housing only.
 Advanced diagnostics and event logging.
 Firmware programming and updates, both local and remote.
 Alarm event transmission via GSM/GPRS/HSPA.
 Priority programmable with PSTN/Cellular.
 Two-way communications with cellphone.
 Optional backup battery: versions with housing only.
 Alarm panel management and status monitoring.
 Anti-jamming.
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Technical specifications

The power for the communicator is supplied by the panel to which it is connected (10.7 V to 27.6 V) or by an external power supply
which also recharges an optional backup battery, if necessary. The sole purpose of the battery is to supply power in case of failure
of the primary power source (8 hours stand-by).

 When the communicator is powered by the battery, ONLY communicator events are transmitted.

The primary power and (optional) battery voltages are supervised.
The power supply for communicator models GS4005, 3G4005-LAT and 3G4005/EU must be SELV, with power limited to 1 A.

Version GS4005-K 3G4005K-LAT 3G4005-K/EU GS4005 3G4005-LAT 3G4005/EU

Input Voltage 10.7 ÷ 27.6 V_

Standby average 
current, without battery

90 mA (not including outputs) @ 13.8 V_

Average current 
consumption per hour

100 mA

Maximum current draw in 
current limited mode

230 mA (not including outputs) @ 13.8 V_

Maximum current draw 450 mA (not including outputs) @ 13.8 V_

Outputs 6 open-collector, 100 mA

Operating frequency 
(MHz)

900/1800
850/1900

GSM: 850/1900
UMTS: 850/1900

GSM: 900/1800
UMTS: 900/2100

900/1800
850/1900

GSM: 850/1900
UMTS: 850/1900

GSM: 900/1800
UMTS: 900/2100

Maximum loop resistance 
of line between the device 
connected in series on LI

1 Kohm

Maximum number of 
parallel devices 
connected on LI

1

Environmental class II

Operating temperature -10 ÷ +40°C

Humidity 0 ÷ 95%

Dimensions (LxHxD) 76x151x20 mm (PCB only) 101x186x41 mm

Weight 66 g 250 g

Table 1 – Technical specifications.
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Identification of parts

Numbers given in bold in this manual refer to the main parts of the communicator shown in figure 1 and 2, and the table on page 2.

Description of jumpers

Interface type between SPT (Supervised Premises Transceiver)
and AS (Alarm System) 

Proprietary interface

ATS (Alarm Transmission System) SINGLE PATH

Alarm Transmission System performance SP4 for digital messages SP2 for vocal/text messages 

Average transmission time D3 (20 s) D2 (60 s)

Maximum transmission time M3 (60 s) M2 (120 s)

Reporting time T4 (180 s) T2 (25 h)

Substitution security S2 S0

Information security I3 I0

Table 2 – EN 50136-1:2012 and EN 50136-2:2013 specifications.

Jumper Position Description

PST oo Pass-Through disabled (factory setting). 
// Pass-Through enabled (see “Pass-Through” on page 61).

USB oo The communicator behaves as a USB Device (factory setting).
// The communicator behaves as a USB Host.

TMP oo Anti-tamper function enabled (factory setting).
// Anti-tamper function disabled.

UFC oo Future use.
JP2 No limit to communicator current draw (factory setting).

Communicator current draw limited to 450 mA.

Table 3 – Description of jumpers.
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Description of indicator lights

The communicator is equipped with indicator lights (LED) which report the following information.

 During initialisation, all LEDs light up for less than 1 second. During factory settings restore, LEDs  and  are off while

LEDs  and  are on.

LED Colour Name Description

Green/yellow GSM signal strength Type of network for packet service (see table 5).
GSM signal strength (see table 6).
Type of communication (see table 7).

Red Fault See table 8.

Yellow Line status On: the communicator has switched to the simulated PSTN.
Slow flashing: line occupied, voice message transmission.

G Green GSM network status Technical assistance LED.
ACT Green USB On: Host.

Off: Device.
Slow flashing: error.
Fast flashing: activity.

Table 4 – Indicator LED.

LED Colour Type of network for packet service

Green GPRS or EGPRS
Yellow WCDMA, HSDPA or unknown (3G version only).

Table 5 – Type of network for packet service.

GSM signal strength

Off Off No GSM signal.
Off On Low GSM signal strength.
On On High GSM signal strength.

Table 6 – GSM signal strength.
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Fault LED

This LED is  usually off. It flashes to indicate a fault. The communicator monitors faults in th e order given in table 8. The most
important fault status is indicated, with the respective number of flashes of the RED LED, as shown in the following table.

Type of communication

Slow flashing Slow flashing Initialisation: the LEDs flash until the communicator receives a GSM signal.
Fast flashing Off SMS incoming: the LED flashes for a few seconds.
Slow flashing Off Remote session: the LED may flash for a few seconds after the end of the session.
Off Slow flashing Voice call: reports the communicator's voice call, NOT that of the panel to which it is

connected, if any.

Table 7 – Type of communication.

Priorities Description Flashes

1 (HIGH) Firmware problem (incorrect firmware): invalid data in external flash memory. 1
2 Power problems: the power voltage falls below 10.7 V. 2
3 Battery problems: the battery voltage falls below 3.4 V. 3
4 Factory PIN: the EN50136 option is  enabled and the User, Installer or Level 4 PIN is that set in the

factory.
4

5 GSM mod ule f ault: t he microp rocessor is  una ble t o commu nicate wit h t he GSM mo dule du ring the
initialisation sequence.

5

6 SIM problem: SIM card PIN check enabled. 6
7 GSM network problem: the radio module is unable to connect to the GSM network. 7
8 GPRS/HSPA network problem: the radio module is unable to connect to the GPRS/HSPA network. 8
9 Future use. 9
10 IP 1 receiver problem: initialisation failure; supervision failure; no ACK. 10
11 (LOW) IP 2 receiver problem: initialisation failure; supervision failure; no ACK. 11

Table 8 – Fault LED.
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Description of terminals

Terminals Description

- Ground: this terminal must be connected to the electrical system ground to protect the device against overvoltage
on the telephone line and to satisfy safety requirements.

LI Internal telephone line: these terminals must be connected to the panel or other communications terminal.
LE External telephone line: these terminals may be connected to the PSTN line.
T1 Factory setting: output, PSTN fault. Programmable terminals: these terminals can be programmed as

described below.
— Open-collector outputs: these outputs can be activated by 
programmed even ts (automatic activation), SMS or by call
recognition (remote activation); see “Output activation” for details.
The maximum current draw per output is 100 mA.
Inputs: these inputs send SMS or voice messages when activated.

T2 Factory setting: output, no cellular network.
T3 Factory setting: input, interconnection present.
T4 Factory setting: output, tamper.
T5 Factory setting: output, GSM fault.
T6 Factory setting: output, Jamming.
M Earth: power negative and common terminals for the open-collector outputs.
+V Power supplied by panel 10.7 to 27.6 V_: make sure it is protected and current limited (Limited Power Source —

LPS) in conformity with EN 60950-1:2006 standard).
To connect the power, use cable of no more than 3 metres length, and 0.75 mm² cross-section. 
For shorter cables, use appropriate cross-sections.
4005 Series 11



Installation

! Connect the power supply and telephone circuits after the communicator is mounted and connected to the building
ground circuit.
Before fitting or removing the SIM card, make sure the communicator is NOT powered up.

 The communicator shall be installed only by a QUALIFIED TECHNICIAN, indoors, in a safe, dry position, away from RF
transmitting equipment.
Position the communicator for good GSM signal coverage.
DO NOT route any cable over the circuit board.
Do not use power cables which are more than 3 m long.

Installing the kit version

The kit version is composed of a board for mounting inside a burglar alarm panel, preferably in a metal enclosure, and an antenna
for connecting to the board with a coaxial cable.
In n ormal ope ration, t he board, an tenna a nd cable may generate electromagnetic fields and  ma y disturb ne arby e lectronic
equipment which is not immune to such fields.
We therefore recommend that the board be positioned as far away as possible from such equipment and the antenna be mounted
to the enclosure's outer surface or far away from it, using the appropriate bracket.
Route only a minimum amount of coaxial cable into the metal enclosure; gather any excess outside the enclosure.

To install the kit version, proceed as described below and in figure 3.

1. Open the panel.
2. Find a place inside the panel to mount the board, including its wiring.
3. Mount the 4 provided adhesive plastic mounts into holes 30 of the communicator, as shown in figure 3.
4. Secure the communicator inside the panel.
5. If the panel has  a plastic housing, or if you want to place the antenna within 2 metres of t he panel, for better GSM signal

strength, mount bracket 27 in the desired position, otherwise go to step 7.
6. Route the antenna cable through hole 26.
7. Position antenna 29 on the panel's metal housing or on bracket 27, so that the magnetic base adheres to the surface.
8. Route the antenna cable through an opening in the housing.
9. Connect the antenna cable to communicator connector 43.
10. Fit the TMP jumper to disable tamper detection.
11. Continue with the installation as described in paragraph “Power and testing” on page 14.
12. Close up the panel.
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Figure 3 – Installing the kit communicator: A) metal housing; B) communicator board; C) panel motherboard; D) adhesive plastic
mount; E) base of metal housing.
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Installing the version with housing

The version with housing must be mounted to a wall with screws and plugs (not included) as described below and shown in figure 4.

1. Open the communicator: insert a f lathead screwdriver into holes 33 and prise the cover off the base, than slide the cover
upwards to separate it from the base completely.

2. If you wish to fit the optional battery LIB2A6, read the following steps, otherwise go to step 7.
3. Remove the electronic board: compress hooks 34 to release the board from the base.
4. Fit the battery as shown in figure 4.

 Make sure the silicon/graphite grommet 12 is in place.

5. Restore the board: first insert its left side under hooks 31, then press the right side gently down until it snaps into place.
6. Connect the battery to connector 22 after having powered the communicator up with terminals +V and M.

 The communicator will NOT operate correctly if it is powered only by the battery when first switched on.

7. Mark the positions for the 8 base mounting holes and the position of hole 13 for the wall-tamper device.
8. Drill holes in the marked positions.
! Take care not to damage any wires or tubes running inside the wall.

9. Route the ducted cables in  the wall through openings 35 or b reak out t he tabs 32 to  route the exposed cab les into the
housing.

10. Mount the base to the wall.
11. Continue with the installation as described in paragraph “Power and testing” on page 14.
12. Close the communicator: remove screw 7 from its parked position; slightly tilt the cover; approach the top of the cover to the

base; slide the cover downwards; press the bottom of the cover against the base until it snaps into place; if necessary, secure
the cover to the base with screw 7 in hole 36.

Power and testing 
1. Fit the SIM card into SIM holder 14 as shown by the arrows, with its contacts facing downwards.

 You must disable the SIM card's PIN before fitting it into the communicator.
We advise disabling call transfer on the SIM card.

2. Set the jumpers as required by your application (see “Description of jumpers” on page 8).
3. Make the connections to terminal block 19 as described in paragraph “Connection example” on page 18.

4. Power up the communicator: all LEDs will light up for 1 second, then LEDs  and  will stay on for a few seconds,

after which LED  will flash 4 times to i ndicate that t he User, Installer and Level 4 Installer PINs are t hose set at t he
factory.

5. Use the Cons ole to ch ange t he PINs , as  described in chapter “PC PROGRAMMI NG” on pag e 35, and enable th e
communicator.

6. Check the signal strength: make sure that at least LED  turns on; if the LED  is on, the signal strength is excellent.

If LEDs  and  are off, the signal is NOT strong enough: reposition the communicator or try installing the optional antenna
ANT5-02 (versions with housing only) or ANT5-15, as described elsewhere.
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Figure 4 – Installing the communicator with housing.
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Installing the antenna ANT5-02

The ANT5-02 has great er gain than the communicator's integrated antenna in the version with housing, and can be mounted
indoors within 2 meters of the communicator, to improve GSM reception, as described below and shown in figure 5.

 Position the antenna to optimise GSM reception.

1. Break the tab closing hole 37.
2. Remove the electronic board: compress hooks 34 to release the board from the base.
3. Remove nut 24 and washer 38 from adapter cable 23.
4. Fit adapter cable connector 39 into hole 37, the secure it with nut 24: washer 38 is not required.
5. Connect adapter cable connector 40 to connector 43.
6. Restore the board: first insert its left side under hooks 31, then press the right side gently down until it snaps into place.

 Make sure the adapter cable is routed as shown in figure 5.

7. Secure metal bracket 28 as desired with holes 41.
8. Route antenna connector 42 through hole 26 in the bracket.
9. Position antenna 29 on the bracket so that its magnetic base adheres to its surface.
10. Connect antenna connector 42 to adapter cable connector 39.

Figure 5 – Installing the antenna ANT5-02.
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Installing the antenna ANT5-15

The ANT5-15 has great er gain than the communicator's integrated antenna in the version with housing, and can be mounted
outdoors within 15 m of the communicator, to improve GSM reception.

Refer to the installation instructions included with the ANT5-15 antenna.

Tamper detection

The ve rsion with h ousing of t he commun icator is e quipped with a  devic e which d etects whe n th e cov er is  open ed an d th e
communicator is removed from the wall (tampering).
Tampering is reported by th e Tamper event, to which actions can be associated (activate outputs, send voice, SMS or digital
message) with the Console: the factory setting is that terminal T5 is floating (it is normally connected to earth) in the event of tamper.
Once you have programmed the function, close the cover and power up the communicator.
After init ialisation, open the cover and c heck that the communicator actually executes the actions programmed for t he tamper
detection.
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Connection example

! Incorrect connections may result in FTC fault or improper operation. Inspect wiring and ensure connections are
correct before applying power. DO NOT route any wiring over circuit boards; maintain at least 1” (24.5 mm)
separation. A minimum 1/4” (6.4 mm) separation must be maintained at all points between Power Limited wiring and
all other Not-Power Limited wiring.

 To ensure conformity with EN 50136-2, the communicator must be connected and programmed as described in paragraph
“Conformity with EN 50136-2:2013” on page 55.

Figure 6 – Connection example: A) Communicator; B) disconnect the telephone line before servicing the unit; C) example
connection of terminal T1 programmed as open-collector output; D) power 10.7 - 27.6 V_; E) terminals T1, T2, T3,
T4, T5 and T6 can be programmed as open-collector outputs or input lines; F) burglar alarm panel; G) connection to
telephone line (PSTN); H) ground connection (obligatory).
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GENERAL DESCRIPTION

The communicator can communicate with central stations and send both SMS and voice messages; it can also simulate a PSTN
line in case of malfunction (phone line failure) or substitute of one completely in areas with GSM coverage in which PSTN calls are
not available.

IT can report alarms over the GPRS network, for reliable, fast communications with central stations equipped with a Su r-Gard
System I, II, III, IV or 5 receiver. The performance of the communicator depends largely on the GSM coverage, and it should not
be installed without having first checked the position of the antenna for best reception (the LED  at least must be on).

The communicator has 6 terminals (T) which can be programmed as follows.

 Due to the nature of the GSM network, the communicator may be used solely for its intended purpose and NOT as a modem
for sending faxes or data or for remote assistance services.

 Output w hich can be activated/d eactivated remotely
(reserved manual) or used for reporting the following events:

 Input for:

 problem with PSTN line;  activate voice dialer;
 problem with GSM network;  activate SMS dialer;
 Fail To Communicate (FTC);  activate digital dialer;
 IP receiver fault;  cancel internal transmissions and delete phone queue;
 power failure;  force communications to GSM.
 tamper;
 panel interconnection fault;
 radio disturbance detected (Jamming);
 antenna fault;
 cellular network fault.
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Access levels

This paragraph describes how to access the communicators functions, according to EN50136 standard.

If the EN50136 option is enabled (factory default; see “Options” on page 41), the communicator can handle all four levels of user
access to its functions. The access levels are as follows.

 Level 1: acc ess to f unction disp lay, indica tions (LE Ds use d t o report f aults, GSM and P STN status) a nd messages
(SMS, voice, etc.) available to all users without PIN; this level does not allow any programming. 

 Level 2 (normal user): access to communicator status inf ormation (e.g. use of the Console t o d isplay the s tatus page,
programming options and events buffer). This level requires a PIN. Factory setting: 000000.

 Level 3 (installer): access to configuration functions including addition, removal and replacement of components and other
operations which direct ly or indirect ly affect the communicator's functions (e.g. upload/download programming opt ions with
the Console, display Status page and events buffer). This level requires a PIN. Factory setting: 111111.

 If the EN50136 option is enabled, the installer must be authorised by the normal user.

 Level 4 (level 4 installer): access t o f irmware upd ates and Status pa ge d isplay. T his lev el requires a PI N.
Factory setting: 222222.

 The level 4 installer must be authorised by the installer.
To ensure compliance with EN 50136-2: 2013, the PINs for access to levels 2, 3 and 4 are 6 digit numbers.
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USB connector functions

The communicator has a USB A connector to enable it to work as a device, to connect it to a PC, or as host, to handle a USB key
(see “Description of jumpers” on page 8).

To connect the communicator to a PC, you need a USB cable with A connectors at each end (hub cable).

The USB interface has the following characteristics.
 Conformity: USB 2.0.
 Full speed data: 12 Mbit/s.
 Max. length of cable: 5 m.
 Max. current in host mode: 500 mA.
 Vout in Host mode: 5 V nominal.
 USB key file system: FAT32.

USB device

The USB interface will be an alternative to communications with the RS232 port (PC-Link). It will have the same functions as the
RS232 and will be used with the Console to:
 update the firmware (level 4 installer only);
 upload/download communicator options and audio files (installer only; the normal user can only upload);
 upload the communicator's events buffer (installer and normal user only);
 check the communicator's status in real time (all users).

USB Host

Allows you to use a USB key for the following operations:
 firmware updates;
 upload/download settings and audio files;
 export the events buffer;
 export the communicator's debug buffer (technical service only).

These functions are available only if the EN50136 option is disabled.
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Power Monitor

The device can be powered in the following ways:

1. by the burglar alarm panel, equipped with a backup battery, in which case the communicator must operate at voltages in the
range 10.7 to 27.6 V.

2. by an external 12 V power supply, in which case the power supply must recharge the communicator's optional backup battery
(8 hours of operation following primary power outage).

In both cases, the battery ensures that the communicator is still operational in case of power failure.

The power and battery voltages are supervised so that the communicator can report the following events:
 Power fault/restore event. 
 Power fault/restore message (voice / SMS / message to the IP receivers).

Since the device can operate with or without an external backup battery (without input current limitation), the following two scenarios
correspond to a power failure.

Power voltage check

The power voltage will be supervised to detect problems. The voltage is checked every 100 ms. The following conditions apply to
the device without external backup battery:

 Power problem event: when the voltage drops below 10.7 V.
 Power problem restore: when the voltage rises above 12 V.
 Start Energy Save mode: every time the voltage drops below 9.6 V.
 Quit Energy Save mode: when the voltage rises above 10.7 V.

 When the communicator is in Energy Save mode, the current draw does not exceed 175 mA. The maximum current
consumption, in Energy Save mode with battery connected and no action in progress is around 70 mA and is less than 150 mA
during voice calls.

Battery voltage check

The battery voltage will be supervised to check for any faults and that the battery itself is present. The voltage is checked every
100 ms. The value is processed (mean of  values) to eliminate peaks. The following conditions apply to the device with external
backup battery:

 Battery problem event: when the battery voltage drops below 3.4 V.
 Battery problem restore: when the battery voltage rises above 3.7 V.
 Start Energy Save mode: when the battery voltage drops below 3.2 V.
 Quit Energy Save mode: when the battery voltage rises above 3.4 V.
 Battery disconnected event: when the battery voltage drops below 2.0 V.
 Battery disconnected restore: when the battery voltage rises above 2.0 V.
 Battery overload event: when the battery voltage rises above 4.4 V.
 Battery overcharge restore: when the battery voltage drops below 4.3 V.

 When the communicator is powered ONLY by the battery, you can NOT use the USB port.
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Internal events

Along with t he e xternal events (panel even ts deco ded wit h th e Cont act I D / SI A prot ocols on t he simulat ed PST N line ),
the communicator also recognises the following events.

Event Description

Input 1 Event This occ urs when te rminal T1 is p rogrammed a s an input an d t he conditions f or it s
activation obtain (see “Inputs/Outputs” on page 44).

Input 2 Event Like Input 1 Event but for terminal T2.
Input 3 Event Like Input 1 Event but for terminal T3.
Input 4 Event Like Input 1 Event but for terminal T4.
Input 5 Event Like Input 1 Event but for terminal T5.
Input 6 Event Like Input 1 Event but for terminal T6.
Input 1 Restore This occurs when terminal T1 is programmed as  an input, and returns to standby status

(see “Inputs/Outputs” on page 44).
Input 2 Restore Like Input 1 Restore but for terminal T2.
Input 3 Restore Like Input 1 Restore but for terminal T3.
Input 4 Restore Like Input 1 Restore but for terminal T4.
Input 5 Restore Like Input 1 Restore but for terminal T5.
Input 6 Restore Like Input 1 Restore but for terminal T6.
Mains Fault Happens when the power voltage (terminal +V) drops below 10.7 V.
Mains Fault Restore Happens when the power voltage (terminal +V) rises above 12 V.
Battery Fault Happens when the battery voltage falls below 3.4 V.
Battery Restore Happens when the battery voltage rises above 3.7 V.
Panel Interconnection Fault Happens when the terminal programmed as the Panel Interconnection Present input

is activated (see “Inputs/Outputs” on page 44).
Panel Interconnection Restore Happens when the terminal programmed as the Panel Interconnection Present input

is deactivated (see “Inputs/Outputs” on page 44).
Cellular Receiver 1 Fault Happens wh en t he c ommunicator is NOT  able t o co mmunicate wit h receive r 1 :

initialisation failure, supervision failure or receiver does not respond (see “IP Receivers”
on page 49).

Cellular Receiver 2 Fault Like Cellular Receiver 1 Fault but for receiver 2.
Cellular Receiver 1 Restore Happens when t he communicator is ab le t o communicate with receive r 1: initialisat ion

successful, supervision successful or rece iver resp onds (see  “ IP Receivers” on
page 49).

Cellular Receiver 2 Restore Like Cellular Receiver 1 Restore but for receiver 2.
PSTN Fault Happens when the voltage on t erminals LE is les s than 2.5 V for the set LE Failure

Timeout (sec) (see “Timeouts” on page 51).
PSTN Fault Restore Happens when the voltage on terminals LE is  more than 2.5 V for the set LE Restore

Timeout (sec) (see “Timeouts” on page 51).
Cellular Network Fault The communicator can NOT connect to the cellular data network.
Cellular Network Restore The communicator can connect to the cellular data network.
Tamper Event Happens when tamper detection is enabled (see “Description of jumpers” on page 8) and

the communicator is opened or removed from the wall (versions with housing only).

Table 9 – Description of events handled by communicator.
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The installer can choose which protocol to use: Contact ID or SIA.

 The selected protocol is also applied to events generated by the panel and sent to the phone numbers with the IP Receiver
on GSM Path option enabled (see table on page 39).

To each event associated with the communicator's inputs, a specific Customer code can be assigned, while status events can be
assigned a unique user code.

The communicator handles a queue of 32 internal events. When the queue is full, further events are ignored.

The priority between internal and external events can be programmed by the installer (see “Priorities” on page 42).

For internal events, the times and manners in which they are sent are handled by the communicators: after a message is sent, the
unit waits for at most 1.25 seconds for the receiver to acknowledge reception (ACK). The unit will try t o send a message up to
4 times. Events are transmitted to the digital receiver (see “Communicator” on page 46).

Tamper Restore Happens when tamper detection is enabled (see “Description of jumpers” on page 8) and
the communicator is closed again or mounted to the wall (versions with housing only).

FTC Fault Happens when an action fails (voice call, SMS, digital message).
FTC Restore Happens when the last action in the queue terminates successfully.
Periodic Call/SMS Happens when programmed (see “SMS/Voice Calls” on page 46).

Event Description

Table 9 – Description of events handled by communicator.
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Operating Principles

The commun icator can choose its  primary channel (the factory se tting is  PSTN). It  supp lies the line and  ringtone vo ltage for
incoming calls and decodes dial tones (DTMF). The simulated PSTN line provides a backup for the burglar alarm panel or other
terminal should the main PSTN line fail. Calls CANNOT be  switched between PSTN and  GSM, or vice-versa, while they are in
progress. Operating priority (as programmed) determines how the communicator handles SMS and voice messages, and calls with
devices connected to terminals LI (for example, a burglar alarm panel).

 The communicator is NOT able to decode pulse dialing.
To prevent undesired use of the simulated line via GSM, the device generates a double beep during voice calls. It does so
after 5 minutes and every 30 seconds thereafter.

PSTN channel

If the voltage on the PSTN terminals (LE) falls below 2.5 V DC (± 20%) for 10 to 3600 seconds (programmable value), the devices
connected to terminals LI are switched to the GSM network. When PSTN service is restored, the communicator switches back
to the PSTN line, again after a programmable delay.

 It is possible to force communications to the GSM/cellular data network, even when PSTN is present, by entering a
programmable prefix (factory setting “9999”) ahead of the phone number dialled by the panel (for further details, see Dialing
Prefix in “PSTN/PTM” on page 51).
If the device is on the simulated GSM line for any reason, the prefix is deleted from the number (if present).

Example: the c ommunicator ma kes indep endent calls o nly o n t he GSM/cellular data ne twork, and not on  t he PS TN line.
All communications made on th e external PSTN line (terminals LE) come from the line connected to terminals LI, and are not
modified. It follows that the PSTN line connected to LE is not considered a communications channel pursuant to EN 50136.

GSM channel

This provides the devices connected to the LI terminals with a simulated line if GSM reception is detected. If there is no GSM
coverage, it switches to PSTN.

Number dialled by 
panel

Phone line
Number with IP Receiver 
on GSM Path enabled

Effect

0123456789 PSTN None PSTN voice call to 0123456789.
99990123456789 PSTN 0123456789 Contact ID call on cellular data network.
99990123456789 PSTN None Voice or Contact ID call on GSM to 0123456789.
99990123456789 Simulated GSM 0123456789 Contact ID call on cellular data network.
99990123456789 Simulated GSM None Voice or Contact ID call on GSM to 0123456789.
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Contact ID/SIA transmission sequence on cellular data network

If phone numbers (prefixes on the PTM page) have been entered on the Console, the communicator switches the calls to these
numbers to the cellular data network.
 When an event occurs, the burglar alarm panel engages the phone line.
 The dial tone is simulated.
 The burglar alarm panel dials the number of the central station. Make sure that the panel inserts at least a 1 second pause or

checks for the dial tone before dialling the number.
 The communicator sends the handshake tone required for Contact ID or SIA.
 After it receives the handshake, the panel transmits the alarm events.
 The communicator decodes and transforms the message into a data packet and sends it to the central station receiver via

the cellular data network.
 The receiver recognises the event and sends an acknowledgement (kiss-off) to the communicator, which forwards the kiss-

off signal to the panel.
 After the communicator has generated the kiss-off signal, if no other events are to be sent, the panel hangs up, or sends the

next event.

SMS dialer

In SMS dialer mode, one or more previously programmed numbers (up to 8 of the numbers in the Phonebook) are sent the SMS
(max. length 70 characters), associated with the events listed in table 9 on page 23.

 An SMS is sent when one of the above listed events occurs, for which an SMS has been programmed and at least one number
has been assigned.

Voice dialer

In voice dialer mode, one or more previously programmed numbers (up to 8 of the numbers in the Phonebook) are sent up to 
3 pre-recorded voice messages. Up t o 150 voice messages can be recorded, of up to  6 seconds each. The messages can be
associated with the events listed in table 9 on page 23.

A voice call is made when an event occurs for which a voice message has been programmed and which has at least one phone
number. In this case, the communicator executes the procedure indicated below.

1. The communicator dials the number and makes the call via GSM.
2. The communicator checks that the number is no t engaged and that there are n o problems with the GSM ne twork before

proceeding, otherwise it terminates the call and tries step 1 again, for the programmed number of times (Call attempts in
par. “SMS/Voice Calls” on  page 46), after which it concludes t he call c ycle. I f t he event has been p rogrammed t o call
multiple numbers, they are called in sequence. This prevents the system calling an occupied number several times in a few
seconds.

3. The commun icator wa its up  to 6 0 sec onds for t he called n umber to  answer. If  th e numbe r an swers, it goe s t o st ep 4,
otherwise it hangs up and tries step 1 again, for the programmed number of t imes (Call Attempts in par. “SMS/Voice
Calls” on page 46), after which it concludes the call cycle.

4. The communicator plays the message for the channel in alarm: the call is terminated only after the message has been received
or th e ca lled us er pre sses  on  his ph one, if the  Call Confirmation o ption is ena bled (se e “ SMS/Voice Calls” on
page 46).

If multiple eve nts re quiring diff erent mess ages to be  sent  to the  same n umber hav e occ urred, t he mes sages are playe d in
sequence, each for the programmed number of Repetitions (see “SMS/Voice Calls” on page 46), during a single call, to avoid
calling the same number multiple times. 

If, at the end of the call cycle, the input which activated the communicator is still in alarm, the above procedure is not repeated.
The input which tripped the call cycle must first be deactivated and then activated anew before a new cycle of calls is tripped.
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Priority handling

The communicator can:
 forward panel voice messages via GSM;
 forward panel Contact ID messages on the GSM voice channel;
 send its own voice messages;
 send its own SMS;
 send its own digital messages (Contact ID/SIA) on the cellular data network;
 handle incoming SMS;
 send data packets for supervising communications with IP receivers.

The priorities of all the above actions can be set on the Console (see “Priorities” on page 42).
The following table shows the factory default priorities.

Factory operation
 If the device is transmitting an event and another event of higher priority occurs, the communicator interrupts transmission of

the lower priority event and queues it.
 After the higher priority event has been transmitted, the communicator tries again to transmit the interrupted (queued) event.
 If several events of the same priority occur together, they are queued and transmitted in sequence.
 The communicator's voice messages have lower priority than panel events: if a panel event occurs while the communicator is

transmitting a v oice message, the communicator hangs up and  the panel takes over the line (pick up det ected); after the
event has been transmitted (hang up detected) the communicator tries again to transmit the interrupted (queued) message.

 If the communicator's voice messages have higher priority and a panel event occurs while a communicator voice message is
being sent, the communicator must provide the engaged signal to the panel and continue transmitting its messages.

 Communicator SMS have lower priority than panel messages and the communicator's voice messages, but an SMS cannot
be interrupted while it is being sent. 

 The lowest priority is given to data packet transmission for supervision of communications with the IP receivers.

N. Action Priorities
Programmable 
on the Console

1 Forward panel voice/Contact ID messages on the GSM voice channel. 0 (HIGH) Yes
2 Send communicator digital messages (Contact ID/SIA) on the cellular data network. 1 Yes
3 Send communicator voice messages/SMS. 2 Yes
4 Handle incoming SMS. 3 No
5 Supervision over the cellular data network. 4 (LOW) No

Table 10 – action priorities - factory settings.
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Pay as you go balance check 

If programmed on the Console (see “Pay As You Go Balance” on page 42), you can check your balance on the prepaid SIM
card. Once enabled, the system can check the pay as you go balance in three ways:
1. On the Console (Status page, only via PC-Link or USB connection).
2. By SMS to request a response to the sender's number. The command must include the normal user PIN.
3. An SMS containing the service provider's pay as you go balance information is periodically sent to the first number in the

Phonebook. For all service providers which support pay as you go balance check with network commands, the query string
can entered with the Console. 

 At the service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended. 

Panel Transmission Monitoring (PTM)

Constantly c ontrolling communications with the pa nel (PTM f unction) enables t he communicator t o se nd calls v ia GSM if
communications between the panel and the central station via the PSTN line fail. If programmed (on the Console, PSTN/PTM
page), this function is only enabled when the PSTN line is connected to terminals LE and is present.

 Pulse dialing detection is not supported.
When the PTM function activates, the PSTN fault event occurs.

The communicator checks the LE lin e and, once it has detected that the line is occupied by t he panel, executes the following
procedure:
 it decodes the dialled number (DTMF);
 if the decoded number has PTM enabled, the communicator check for the Kiss-Off signal (it acknowledges the reception of

the event sent from the panel to the central station).

The panel must make the call immediately: the time between picking up and making the call, programmed on the panel, must be
at least 2 seconds.

If the PTM All Numbers option is enabled (see “PSTN/PTM” on page 51) the communicator will check for the kiss-off for all
calls.
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Activating outputs

The communicator has 6 terminals (T1, T2, T3, T4, T5 and T6) which can be programmed as Inputs or Open-Collector Outputs.
The Open Collector outputs can be activated automatically (when certain programmed events occur) or remotely, by SMS or caller
recognition using a preprogrammed number.

Automatic output activation/deactivation

The Open Collector outputs of the communicator may be activated automatically by the following events.

 Panel interconnection fault: activated when the connection with the panel is not present.
 Jamming detect: the output is activated by detection of jamming (terminal T6, factory setting).
 Antenna fault: the output is activated when the antenna is missing or the antenna has limited function (ANT5-02 only).
 Tamper: the output is activated when tamper is detected (terminal T4, factory setting).
 PSTN fault: the output is activated when the PSTN malfunctions (terminal T1, factory setting).
 GSM fault: the out put is  activated when th e GSM fails, a SI M problem oc curs, or th ere is no sign al (terminal T5,

factory setting).
 No cellular network: the output is activated when the data connection fails (terminal T2, factory setting).
 IP receiver fault: the output is activated when communications with the IP receivers fail.
 Power fault: the output is activated when there is a power fault or failure.
 FTC fault: the output is activated when an event send fails.

 An automatically activated OC output returns to standby when all the causes that tripped it are resolved, except for FTC fault,
in which case it returns to standby after a set delay (ON time).

Remote output activation/deactivation

 The GSM connection must be present for the outputs to be remotely activated/deactivated.
We recommend the device is programmed with the Black List Enabled (Options > Dial Options) and White list disabled
(Phonebook) for the numbers you wish to use for this function.
The number used to activate the outputs using Caller ID must NOT be concealed (it must NOT be a private number).
When terminals T1, T2, T3, T4, T5 and T6 are programmed as outputs, they may be controlled remotely via SMS and Caller ID.
The SMS is never saved to the device, but is deleted as soon as the command has been executed.
To enable this function, the output must be configured as a Reserved Output.

The Open-Collector outputs can be programmed as Bistable or Monostable:
 Bistable outputs are activated/deactivated with two separate commands;
 Monostable outputs stay active for the programmed Monostable Time On, after which they return to standby, or until

they are deactivated by SMS.

Each output can be programmed to return a confirm signal:
 a previously programmed SMS, if the output was activated/deactivated via SMS;
 a confirm ringtone, if Caller ID was used.

 If Caller ID is used, the call hangs up automatically 12 seconds after the output is activated.
For further details on the Control String and User Code options used in the following paragraphs, refer to paragraphs
“Inputs/Outputs” on page 44 and “Options” on page 41.
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Bistable outputs 

Open Collector outputs configured to be bistable may be activated in two ways:

1. By sending an SMS consisting of the pound (#), the User Code, the Control String (Control String can not have initial
blank spaces) and the characters =ON*, as follows:

#User Code*Control String=ON* (example: #123456*HOMELIGHT=ON*)

2. Using Caller I D: in th is ca se, t he output is a ctivated wit hout c harge, sinc e o nce the dev ice h as recognised t he caller, it
activates the output without accepting the call.

 An OC output configured as bistable can ONLY be deactivated by an SMS composed of the pound (#), the User Code, the
Control String and the characters =OFF* using the following syntax: 

#User Code*Control String=OFF* (example: #123456*HOMELIGHT=OFF*)

 The 6 digit user code is factory set to 000000; to replace it, see “Changing the user code” on page 32.

Monostable outputs

OC outputs configured as monostable can be activated in 2 ways: by SMS and using Caller ID.

SMS

Send an SMS composed of the pound (#), the User Code, the Control String (Control String can not have initial blank spaces)
and by the characters =ON*, =ON*TonU* or =OFF* using the following syntax:

#User Code*Control String=ON* 

#User Code*Control String=ON*TonU*

#User Code*Control String=OFF*

The =ON*TonU* parameter sets the ON time from 1 to 86400 seconds, with a resolution of 1 second. The ON Time can be set
by means of the Communicator's Console software. Ton is the required value and U is the unit in hours (H), minutes (M) and
seconds (S), as shown in the following example:

 To activate the output with an SMS using the programmed settings, remove the parameter TonU and leave the characters **.
(Example: #9876*HOMELIGHT=ON**).
If the monostable output is programmed incorrectly, the output will be activated for the Monostable Time On set in the
Console. 

SMS Example Effect

#123456*HOMELIGHT=ON* Bistable activation.
#123456*HOMELIGHT=ON** Activated as programmed.
#123456*HOMELIGHT=ON*3600S* Active for 3600 seconds.
#123456*HOMELIGHT=ON*50M* Active for 50 minutes.
#123456*HOMELIGHT=ON*3600* Activated as programmed, the invalid ON time parameter is ignored.
#123456*HOMELIGHT=ON*000S* Activated as programmed, the invalid ON time parameter is ignored.
#123456*HOMELIGHT=OFF* Deactivated.
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Caller ID

The output is activated free of charge, since after it has recognised the caller, the device activates the output without answering
the call.

 Monostable OC outputs return to standby after the programmed Monostable Time On.
The Monostable Time On can be set from 1 second to 86400 seconds, with a 1 second resolution.
The default User Code is 000000; if you wish to change it, please refer to “Changing the user code” on page 32.
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SMS Programming

In addition to the processes described in the paragraph “Remote output activation/deactivation” on page 29, it is also possible to
carry out other remote procedures through the transmission of various SMS messages.

Changing the user code

The default user code is 000000; to change it, send an SMS message consisting of the characters #CUC followed by the current
user code and the new user code between * characters, in accordance with the following formula:

#CUC*User code*New user code*

The device will send an SMS to confirm that the user code has changed.

 The new user code must be 6 digits long (0-9).

Enabling/disabling remote programming

Remote programming allows you to operate the Console over a network. To set the communicator's parameters remotely, you must
enable remote programming, either with the Console (see “Network Settings” on page 43), or wit h an SMS comp osed of the
characters #ERA followed by the User Code and ON enclosed in * as follows:

#ERA*User code*ON*

To disable remote programming, send the following SMS:

#ERA*User code*OFF*

The device will confirm with an SMS.

Changing the installer code

The 6-digit installer code is used to access the remote programming interface (see “Installer Authentication” on page 41). The
default installer code is 111111; to change it, send an SMS message consisting of the characters #CIC followed by the current
Installer code and the new Installer code between * characters, in accordance with the following formula:

#CIC*Installer code*New installer code*

 The new installer code must be 6 digits long (0-9).
If the EN50136 option is enabled, the installer must be authorised by the normal user for the installer code change to
take effect.

The device will send an SMS to confirm that the installer code has changed.

Changing the level 4 installer code

The default level 4 installer code is 222222; to change it, send an SMS composed of the characters #CMC followed by the current
Level 4 Installer code and the new Level 4 Installer code enclosed between *, as follows:

#CMC*Level 4 installer code*New level 4 installer code*

 The new level 4 installer code must be 6 digits long (0-9).
For the Level 4 installer code change to take effect, the Level 4 installer must be authorised by the installer.

The device will send an SMS to confirm that the level 4 installer code has changed.
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Pay as you go balance check 

To check your pay as you go balance with an SMS, you can either use the Console (see “Pay As You Go Balance” on page 42)
or send an SMS composed of the characters #CCC followed by * and the user code, as follows:

#CCC*User code*

or #ICCC followed by * and the installer code, as follows:

#ICCC*Installer code*

 You will receive an SMS with the pay as you go balance.
At the GSM service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.
If the EN50136 option is enabled, the installer must be authorised by the normal user for the command to work.

Checking the expiration date

To find out the expiration date of the SIM card with an SMS, send an SMS composed of the characters #EDC followed by * and
user code, as follows:

#EDC*User code*

You will receive an SMS with the expiration date.

Updating the expiration date

To update the SIM card's expiration date with an SMS, send an SMS composed of the characters #EDU followed by *, the user
code and the new date, as follows:

#EDU*User code*new date*

The date must have the format DD/MM/YYYY.

 If an expiration date has NEVER been set on the Console, the expiration time is set to 10:00 AM.
If a date and time of expiration have been set with the Console and you then change the expiration date with an SMS using
the command #EDU, the expiration time is unchanged.

Checking the serial number

This command is used to check the communicator's serial number with an SMS composed of the characters #RID followed by *
and the user code, as follows:

#RID*User code*

or #IRID followed by * and the installer code, as follows:

#IRID*Installer code*

The device will respond with the RID: 01234567.

Enabling the installer

To enable the installer to work with the device, the user must send a SMS composed of #ENI followed by the User code as follows:

#ENI*User code*

The device will confirm with an SMS.

 The installer must be enabled only if the EN 50136 option is enabled; if not, the installer is always enabled.

 

4005 Series 33



Disabling the installer

To disable the installer from working with the device, the user must send a SMS composed of #DSI followed by the User code as
follows:

#DSI*User code*

The device will confirm with an SMS.

 The installer is disabled automatically 12 hours after being enabled.
Disabling the installer also automatically disables the level 4 installer.

Enabling the level 4 installer

To enable the level 4 installer to work with the device, the installer must send a SMS composed of #ENM followed by the Installer
code as follows:

#ENM*Installer code*

The device will confirm with an SMS.

The level 4 installer is automatically disabled after 12 hours.

Start a remote session

To start a remote communicator session, send an SMS composed of #SRS followed by the Console IP and the Console port
between *, as follows:

#SRS*Console IP* Console port*

where:
 the Console IP if the public IP of the PC in the format “AAA.BBB.CCC.DDD” (e.g. 37.207.123.181) or host/domain na me

format (Fully Qualified Domain Name, e.g. “my_name.dyndns.org”);
 the Console port is the IP port in the format “NNNNN” (a 5 digit number in the range 1 to 65535).

 You must set the router to which the Console's PC is connected to enable port forwarding from the Console port to TCP port
51004 (the port used locally by the Console, this is NOT editable): ask your network administrator or refer to the router's
instructions.

The APN specified in the Console Network Settings page will be used, or the one programmed for Receiver 1 (IP Receivers
page).

If no APN has been programmed (neither in the Network Settings page nor in the IP Receivers page), the SMS must specify
the connection as follows: 

#SRS*Console IP*Console port*APN access point name* 

In some cases, if the APN USERNAME (max 32 characters) and PASSWORD (max 32 characters) are set , the above string is
sufficient to initiate a session, otherwise the string must be modified as follows:

#SRS*Console IP*Console port*APN access point name*User name*Password*
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PC PROGRAMMING

 For the communicator to work properly, you must use a 32 kB or better SIM card.

To program the system with a PC, you need a PC-Link cable (not included), connected between connector 15 of the communicator
and a PC COM port, and the Console (Figure 7). Take care to insert the PC-Link cable properly. Once the connection has been
made, select the COM with Tools > Modem Manager Configuration. If you have a problem with communications, check the
cable and the serial port settings.

Figure 7 – PC-Link cable connection: A) RS-232 connector, solder side B) insert the PC-Link cable properly.

Alternatively, connect the communicator to a PC with a USB A-A cable (hub cable), see “USB connector functions” on page 21.

 To install and run the Console, you must have admin rights on the PC; we also recommend that you check the firewall settings
if you encounter problems during the installation procedure.
The Console can be downloaded from www.dsc.com.

1. Install the Console.
2. Run the Console.
3. Select the user name and  enter the password to enter the session: the factory setting uses the username admin and the

password is 1234.
4. Open the File menu and click on New Account to c reate a new ac count or open an a ccount listed in t he Start Page:

double click on the account to open it.

 To change the Console's language, click on Tools > Edit Current User; select the language in the next page.
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Description of the menus
 File menu
 New Account: Creates a new account and assigns the factory settings to all parameters.
 Account Group Maintenance: groups several accounts into a group.
 Recent Files: selects an existing account.
 Exit: Exits the program. You will be prompted to save any changes made to the current installation.
 View menu
 Start Page: equivalent to clicking on the Start Page tab.
 Toolbar: opens the Account Group Maintenance field.
 Operators Online: list of connected users.
 Open Accounts: list of saved accounts.

 Communication Jobs: lists the communication sessions; you can also click on .
 Recent Activity: list of recent activity.
 Tools menu
 Language Manager: modifies, imports/exports, creates new languages.
 DLS 5 v1.50 Operator Maintenance: in this window, the administrator can modify his password and set the password

for a user (with possible functional restrictions—Edit Operator Roles) for the Console.
 Modem Manager Configuration: sets the type of connection: PCLINK or COM port.
 Edit Current Operator: see previous page for changing the Console language.
 Backup/Restore Database: sets the database management options.
 Recycle Bin: select the account and delete it.
 Window menu
 Close All Tabs: closes all open account tabs.
 Start Page: equivalent to clicking on the Start Page tab.
 Help menu
 About DLS: displays the Console version. 
 End User License Agreement: displays the text of the license agreement.
 Updates: Check For Updates—Show Installed Updates—Manually Install Update.
 Send Feedback: send a comment to the manufacturer

Description of icons

 Global Upload: displays the communicator's settings on the PC.

 Global Download: once a new account has been programmed (or an existing account has been modified), sends the new
settings to the communicator.

 Save: if you change the settings for the existing account, click on Save to save the new configuration.

 Connect Only.

 Communicate Tags.

 Upload Event Log.

 Clear all tags.

 Disconnect When Complete.

 Programming/Audio Import/Export.

 Select User: displays only information relating to the Normal User, Installer or Level4 Installer.

 Option Name Search: enter the name of the option to the left of the icon.
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Icons present on all programming pages.

 Clear all tags for this group.

 Export.

 Restore all options to default.

 Restore all options to original.

 Tag all for upload: select all page options for upload.

 Tag all for download: select all page options for download.

The following pages are available in the programming section.

 Phonebook: the phonebook page.

 Options: options page.

 Firmware Update: the icon only displays when the Level 4 Installer is enabled and is updating the firmware in this page
(see icon Select User).

 Network Settings: connection settings page

 Inputs/Outputs: programs the communicator's inputs and outputs.

 Communicator: communicator programming page.

 IP Receivers: programs all IP receiver options.

 Voice Messages: voice message management page.

 PSTN/PTM: configures the PTM function.

 Event Log: configures the event buffer.

 Status: communicator monitoring page.

If you wish to configure a new account, go to File > New Account.

To display the list of accounts in the database, select View > Start Page or click on Start Page. In this section you can delete
or recall the configuration for a given account as follows:
1. Right click on the account name.
2. Select Open to load the data from the database or Delete to delete the account and all its settings from the database.

To load an account, you can simply double-click on the account name.

You can also order the list alphabetically or by code by clicking on the header of the column in question.

All settings are available on the following pages. This chapter describes in detail the application's pages.

 Depending on your level of access (Normal User, Installer or Level 4 Installer) the settings pages will display differently.
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Programming/Audio Import/Export

Button  opens a window with the following functions.

Restore Factory Settings

To restore the communicator's factory settings, proceed as follows.

1. Shut off power to the communicator.
2. Short pins 1 and 4 of the PC LINK 15 connector and restore power. 
3. All LEDs will turn on, and after a few seconds the green ones will turn off to indicate that the factory restore is in progress.
4. You can now remove the short connection between pins 1 and 4 of connector 15.

5. Once the procedure terminates, the LEDs  will f lash to indicate that the PINs have been restored to their values; the
other LEDs remain off.

 Recorded voice messages are NOT deleted by the factory restore procedure. Voice messages can be deleted in the Console's
Voice Messages page.
The factory restore procedure may NOT be executed if the communicator is ONLY powered by its backup battery; you must
reconnect its primary power supply. 

Export Programming: click on this button to export the current settings from the Console to a USB key.

Import Programming: click on this button to import a communicator's settings from a USB key to the Console; the
settings may be those previously exported from a Console running on another PC, or from a communicator.

Export Audio: click on this button to export the voice messages from the Console to a USB key.

Import Audio: click on this button to import the voice messages from a USB key to the Console; the messages may
be those previously exported from a Console running on another PC, or from a communicator.
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Phonebook

You can save up to 32 phone numbers in this page.

 If the periodic pay as you go balance function has been programmed for the communicator's SIM card (see the Options page)
the answering SMS is sent to phone number #1.

 Label: enter an alphanumeric string of at most 16 characters.
 Phone Number: enter a phone number with the international dialing prefix in the format “+xxx” (e.g.: +39 for Italy). Up to

16 digits at most are allowed (the “+” counts as a character).

 The numbers in the phonebook are used to activate outputs, for the SMS communicator, the voice communicator, the
IP receiver and for PTM (Panel Transmission Monitoring).

 White List: enable or disable th e White List option t o e nable the commu nicator to  ac cept or ref use incoming  calls.
The Communicator accepts incoming calls, forwarding them to the telephone devices connected to LI terminals (such as a
burglar alarm control panel); this is possible only if LI is active as a simulated line via GSM. The way the White List works
depends on whether t he Black List Enabled opt ion is enabled or not  (see Options > Dialing Options); s ee t he
following table.

 Activate Output: click on [+] to select the outputs (1 = T1, 2 = T2, 3 = T3, 4 = T4, 5 = T5 and 6 = T6) to activate when the
communicator receives a call from the number in question. This function is independent of the White List and Black List
Enabled settings in Options > Dialing Options. To activate the output, Caller ID mu st be enabled, for the number in
question.

 To activate the output, set terminal T1, T2, T3, T4, T5 or T6 as Output and enable Reserved Output option (see Inputs/
Outputs page).

 Output Activation Confirmation: check this box to receive a ring tone to confirm activation of the output.

 The ringtone will sound 1 minute after the output has been activated.
If the communicator is busy with another operation (for example, the GSM channel is busy with voice communications),
the ringtone will not be sent.

 PTM: enable this options to activate the “PTM” function for the number in question. Use this option to monitor the panel's
calls to a PSTN receiver's number (central station). Factory setting: disabled.

 CID/SIA Event Conversion: enables sending of messages by voice or SMS, by decoding the panel's CID/SIA packets
(see table 1 1 on page 40).

 Virtual Receiver on GSM Path: if CID/SIA Event Conversion is enabled and the option IP Receiver on GSM
Path is disabled, this function forces the communicator to simulate a receiver (the communicator sends a handshake and
kissoff to the panel).

 IP Receiver on GSM Path: en ables decoding of  ev ents t ransmitted by  th e pan el to  th e pho ne nu mber and  th e
transmission of events on the cellular network to IP receivers (central station).

White List Black List Enabled Mode

Disabled Disabled Accepts incoming calls from any number.
Enabled Disabled Accepts incoming calls from any number.
Disabled Enabled Refuses any incoming calls.
Enabled Enabled Accept inco ming c alls on ly f rom numb ers h aving an enabled White List

option, refuse call coming from all other numbers
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PSTN/

GSM1
Communication 

protocol2

CID/SIA 
Event 

Conversion

 Virtual 
Receiver on 
GSM Path

IP Receiver 
on GSM 

Path
Effects

PSTN No effect Disabled No effect No effect The pane l's voic e and d igital mes sages (SIA a nd
CID) are forwarded to PSTN.

PSTN SIA / Contact ID Enabled No effect No effect The panel's voice and digita l mess ages are
forwarded to PSTN.
The digital messages are converted to voice or SMS
messages (as set in the Communicator > CID/

SIA Converter page) and forwarded on GSM3.
GSM No effect Disabled Disabled Disabled The pa nel's voice messages are forwarde d to

GSM4.
GSM Contact ID Enabled Disabled Disabled The pa nel's voice an d digit al mes sages (CID) are

forwarded to GSM4.
The digital mes sages (CID) are c onverted to voice
or SMS messages (as set in the Communicator >
CID/SIA Converter pag e) and f orwarded
on GSM3. 

GSM SIA / Contact ID Enabled Enabled Disabled The digital messages (CID or SI A) are converted to
voice or SMS mess ages (a s se t in t he
Communicator > CID/SIA Converter page )
and forwarded on GSM3.
The communicator simulates a receiver by supplying
the handshake and kissoff messages.

GSM SIA / Contact ID Disabled Disabled Enabled The digit al mes sages (CID/SIA) are de coded and
forwarded on the cellular data network to the IP
receivers.
The communicator simulates a receiver by supplying
the handshake and kissoff messages.

GSM SIA / Contact ID Enabled Disabled Enabled The digit al me ssages (CI D/SIA) are decoded and
forwarded on the cellular data net work to  the IP
receivers.
The communicator simulates a receiver by supplying
the handshake and kissoff messages.
The digital messages (CID or SI A) are converted to
voice or SMS mess ages (a s se t in t he
Communicator > CID/SIA Converter page )
and forwarded on GSM3.

Table 11 – Effects of the CID/SIA Event Conversion, Virtual Receiver on GSM Path and IP Receiver on GSM Path
options on the communicator's operation.
1) Refers to the communications channel used by the communicator.
2) See the Options page.
3) Only if the panel's communications protocol is compatible with that of the communicator.
4) SIA and CID messages may NOT be understood by the receivers due to distortion on the GSM network.
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Options

 This page differs depending on the user's access level: normal user, installer, level 4 installer.

User Authentication
 Installer Code Enabled: the normal user uses this option to enable the installer for programming the communicator.

 The installer need only be enabled if the EN50136 option is enabled.
The installer is disabled automatically 12 hours after being enabled.
Disabling the installer also automatically disables the level 4 installer.

 User Code: enter the normal user code here (at most 6 digits ), for use, among others, in remotely activating the outputs.
Factory setting: 000000.

Installer Authentication
 Installer Code: enter the installer code here (6 digits). Factory setting: 111111.
 Level 4 Installer Code Enabled: the installer can enable the level 4 installer code for communicator firmware updates

here.

 This option is disabled if the EN50136 option is disabled.

 EN50136: the installer can enable/disable the EN50136 option in this box.

 To ensure conformity with EN 50136-2, the EN50136 option should NOT be disabled.

Level 4 Installer Authentication
 Level 4 Installer Code: enter the level 4 inst aller code here (6 digits). This code gives access to firmware updates and

Status page display. Factory setting: 222222.

Dialing Options

This section configures certain aspects of the phone numbers.

 Dial Prefix: the number entered in th is box is p laced before any number dialled by the communicator in GSM Interface
mode. Enter the prefix (1 to 8 digits) or leave the field empty, if unused.

 Digits to Remove: if the communicator is  connected to a phone switchboard, the phone numbers (programmed in the
panel) mus t be  preceded by t he swit chboard number (normally  a single digit).  Since t he swit chboard number is not
necessary when calls are made to the GSM network, it must be removed from the number. Enter the number of digits that
form the switchboard number (e.g. if switchboard number is 01, enter 2 in the Digits to Remove option, as 2 numbers form
the switchboard number).

 The phone number must have at least two digits more than the number entered in Digits to Remove, otherwise the engaged
tone is generated.

Example:

1. Set the Dial Prefix = 9999 and set Digits to Remove to 2 on the communicator.
2. Configure a voice call on the panel using the number 9999011234567890.
3. Activate the call on the panel.
4. The communicator will send the call to the number 1234567890.

 If the Digits to Remove option is enabled and the panel calls a number which has CID/SIA Event Conversion enabled
(see Phonebook), the phone number in the phonebook must match the one programmed on the panel (including prefix), in
order for the communicator to convert it.
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 Black List Enabled: if enabled, t he commun icator accepts ONLY calls f rom numbe rs whos e White List op tion i s
enabled (see “Phonebook” on page 39).

 The Black List function COMBINED with Activate Output on Caller ID delays call refusal by a few seconds. The
confirmation ring tone associated with Activate Output on Caller ID delays call refusal by a few seconds. If the call is refused
immediately, the output has not been activated.

 Tones: select the country of Communicator installation; the selected country will set adequately a series of parameters for
the proper working of the simulated telephone line.

 Roaming Enabled: enables GSM roaming.

Priorities

This options allows you to configure some priorities on the communicator relating to alarm event transmission.

 Dialer / LI Priority: defines the priority of the communicator (send voice messages, SMS and digital messages to central
station receivers) and the LI (events transmitted by devices hooked up to the LI terminals, such as a burglar alarm panel). 

 Dialer Events Priority: sets the priority o f the communicator (e .g. 1:Rx; 2:Ring; 3:Digital Calls; 4:Voice Calls;
5:SMS).

Generic

This section sets the loudness of the GSM communicator's speaker and microphone.

 Speaker Volume: set the communicator's speaker volume: change this setting if the panel connected to terminals LI of the
communicator is unable to decode the DTMF commands.

 Microphone Volume: set the communicator's microphone volume: change this setting if the user is unable to understand
the voice messages sent by the panel connected to terminals LI of the communicator or by the communicator itself.

 A high microphone volume setting can corrupt the DTMF tones from devices connected to terminals LI, and make them
incomprehensible.

 Enable Antenna Cut Detection: if enabled, the Antenna Fault event is tripped when the antenna is not present or in
short circuit.

 Enable Battery Detection: if enabled, the Battery Fault event is tripped when battery faults are detected.

Automatic Clock Adjust

The options of this section is for the automatic synchronisation of the communicator's clock.

 SIM Phone Number: enter the phone number of the SIM card in the communicator (up to 16 digits).
 Auto SMS: if enabled, the communicator updates the system date and time by sending an SMS to the number specified in

the SIM Phone Number option. Factory setting: enabled.
 IP Clock Adjust: if e nabled, t he c ommunicator ge ts th e dat e a nd t ime from t he I P rece iver 1, w hen c onfigured an d

connected. Factory setting: enabled.

 In order to ensure compliance with EN 50136-2, the Auto SMS and IP Clock Adjust options must be enabled.

Pay As You Go Balance

 At the service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.

This se ction con figures th e sy stem so t hat an  SMS co ntaining t he se rvice prov ider's pay  as y ou g o balan ce inf ormation is
periodically sent to the first number in the Phonebook. Program the following options for a proper pay as you go balance request,
depending on the service provider in question:
 Enquiry Type: select the type of request (none, SMS, Call, Service Command).
 Enquiry Number: telephone number to call or to which an SMS message should be sent in order to request credit balance

information.
 Balance Message: string used in the SMS requesting the balance using network commands.
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 Enquiry Interval: enter the interval within which the periodic SMS is to be sent with the balance information (if handled by
the operator). The interval is composed of the following values:
— Days, day of next send—select to send the next periodic SMS. The value runs from 0 to 364;
— Hours, time of next send—select to send the next periodic SMS. The value runs from 0 to 23.

SIM Expiration
 SIM Expiration Message: enables sending the SMS (user programmable) with the expiration data to the first number in

the phonebook.
 SIM Expiration Date: once the expiration date is set, the message is sent 30, 15, 7, 6, 5, 4, 3, 2 and 1 days prior to the

expiry date itself. Click on Now to set the PC's time.

 The SMS is sent once every programmed day: if it fails, no further attempt is done.

Protocol Settings
 Handshake Repetition: set the number of handshakes generated by the communicator and sent to the panel connected

to terminals LI. Range: 1 to 4.
 Communication protocol: select the protocol: Contact ID or SIA.

 Depending on this setting, the communicator will decode CID or SIA events from the panel connected to the LI line; the setting
must be the same for all numbers handled by the communicator.
The installer must check that the operator (Wind, Tim, Vodafone, etc.) works reliably with CID (Contact ID) on the GSM
network, due to issues with transmission quality.

Network Settings

This page is used for starting a session / programming remotely

 Device ID: enter the Communicator's serial number you can find on the Communicator’s electronic board.
 Remote Access: check this box to enable remote programming.
 Remote Access APN: access point name, up to 32 characters. This is generally supplied by the cellular network operator.
 Remote Access User Name: some operators require user authentication; enter the user name in this field. 
 Remote Access Password: enter the password in this field.

 See paragraph “Start a remote session” on page 34.
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Inputs/Outputs

This page is used for setting the input/output modes, the output activation events, their standby polarity (NC or NO), the reserved
outputs, and the remote activation SMS strings for the reserved outputs.

 Input/output: double click on the input/output number to view the settings.
 Label: enter an alphanumeric string of at most 16 characters.
 I/O Type: in this column you can program terminals T1, T2, T3, T4, T5 and T6 for the following modes:

— Input, select this mode to configure the terminal as an input line;
— Output, select this mode to configure the terminal as an open-collector output;

 Polarity: this option is used to program the output/input standby status:
— Normally Closed: the terminal is grounded (negative) when the input/output is at standby;
— Normally Open: the terminal is floating when the input/output is at standby.

 Output: if set as output, double click on [+] to display the column relating to the event to program for the output. The check
mark indicates that the output in question will be activated when the event occurs. Click on the boxes to check/uncheck them.

 Programming events for an output implies that certain boxes relating to the output are disabled.

 Panel Interconnection Fault: if selected, the output is activated when the panel is not present.
 Jamming Detect: if selected, the output will be activated if the device is subject to radio disturbance.
 Antenna Fault: if selected, the output is activated if the antenna is not present or has limited function (only with ANT5-02).
 Tampers: if selected, the output will be activated when tampering is detected (opening the cover, removal from the wall).
 PSTN Fault: if selected, the output is activated if the external phone line fails (connected to the LE terminals).
 GSM Fault: if selected, the output is activated if GSM network coverage fails.
 No Cellular Network: if selected, the output is activated when problems occur with the cellular network connection.
 IP Receiver Fail: if selected, the output is activated whenever a problem occurs with the IP receiver.
 FTC Fault: if s elected, t he ou tput is activated when a phone a ction d oes NOT  t erminate s uccessfully and ret urns to

standby when the most recent phone action terminates successfully.
 Power Fault: if selected, the output is activated when a power problem is detected.
 Reserved Output: if selected the output may be activated by Caller ID or SMS.

 If the Reserved Output option is enabled, all other options are disabled.

 Control String: in this option, enter the string (maximum 16 alphanumeric characters) to be sent by SMS when you wish to
activate/deactivate the corresponding output remotely. This function is available even if Caller ID is not enabled.

 Activation Confirmation: select the type of confirmation you want to receive when the output is activated: none, Ring,
SMS (NOT available when the Control String option is left blank) and Ring + SMS. If the output is activated by an SMS,
the activation confirmation will be sent by SMS (see table below).

SETTINGS EFFECTS

 Black List 
Enabled

White List
Activation 

Confirmation
Call Forwarded 

(only if the communicator is switched to GSM)
Confirmation 

Ring

Disabled Disabled None YES NO
Disabled Disabled Ring NO YES
Disabled Enabled None YES NO
Disabled Enabled Ring NO YES
Enabled Disabled None NO NO
Enabled Disabled Ring NO YES
Enabled Enabled None YES NO
Enabled Enabled Ring NO YES
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 Type: normally the outputs, when activated, remain so until a deactivation command is received (Bistable), at which point
the output will revert to its standby status. If you wish the output to return to standby automatically after a set period of time,
select the option Monostable and set this time in the option Monostable Time ON next to it.

 Monostable Time ON: enter a value in seconds (1 to 86400 in 1 second steps) to indicate the time for which the output,
if monostable, remains active before returning to standby.

Input

When a T1, T2, T3, T4, T5 or T6 terminal is configured as an input, it can be programmed as Normally Open or Normally
Closed (see Polarity). The input is polled at least every 30 ms and, if its state remains stable for more than 300 ms, Input 1
Event is generated (for terminal T1).

The following options are available when programming the inputs:
 Panel Interconnection Present: if enabled , deac tivation of the input  ge nerates t he Panel Interconnection Fault

event and activating the input generates the Panel Interconnection Restore event.
 Dialer Block: if enabled, activating the input blocks the communicator and deletes the queue.
 Force Communication on Simulated Line: if enabled, activating the input switches from PSTN to GSM.
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Communicator

This page configures the events transmitted by the communicator.

SMS/Voice Calls
Call Options

 Call All Numbers: select this option to call all numbers set for a given event.
You can select: Voice Calls, CID: Over GSM, Voice Calls and CID: Over GSM and Disabled. If this option is not
selected, the communicator terminates the cycle of calls as soon one of them terminates successfully. 

 Call Confirmation: select this option to have the dialer wait for the remote user to confirm reception of the voice message,
otherwise the dialer will t ry sending the voice message again; the remote user can confirm by press ing  on his phon e
(for tone dialling phones only).

 While listing to a voice message, pressing  on the phone keypad blocks both the current call and any queued calls as well.
In some cases the dialer may interpret the response of answerphones, GSM operator courtesy messages and so on, so we
recommend leaving Call Confirmation enabled.

 Repeat Call: this option is used to enter the number of at tempts to be performed (up to a maximum of 8) if  the call is not
successful.

 Repetitions: enter the number of times the voice message is to be repeated (up to 8) when the called number answers.

Periodic SMS and Voice

 Periodic SMS/Call Send Interval: s et t he int erval (Days and Hours) bet ween two Periodic Call/SMS ev ents.
Range: 0 to 365 days and 0 to 23 hours.

 Periodic SMS /Call First Send: select the date and time for sending the first Periodic Call/SMS event.
The 24hr/12hr button allows you to select the time display format: 12 hour or 24 hour.
The Now button sets the PC's current time.

 In order to ensure conformity with EN 50136-2, the Periodic SMS/Call First Send time must be set to 1 day, and this
function may not be modified. Factory setting: 1 day.
To set the options for Periodic SMS/Call First Send, enter the SIM Phone Number and enable Automatic Clock
Adjust options in the Options page.

 Ring only for periodic event: with this opt ion enabled, the system sends a 5 s ring  tone instead of a periodic voic e
message.

Phone Number Use

This table specifies which numbers in the  Phonebook are to b e used for se nding SMS ( SMS Phone Numbers) and voice
messages (Voice Dialer Phone Numbers): you can choose up to 8 numbers for each option.

Events—Actions

This table specifies, for each event handled by the communicator, the voice or SMS messages to send to the numbers specified in
the table Phone Number Use.

 Label: this column lists the events for which a voice or SMS message is to be sent.

 Input 1 Event (or 2, 3, 4, 5, 6) and Input 1 Restore (or 2, 3, 4, 5, 6) only occurs if terminal T1 (or T2, T3, T4, T5, T6) is
configured as an input (see Inputs/Outputs).

 Telephone Numbers: select the numbers to which the event is to send a voice message.

 The phone numbers are those selected in the line Voice Dialer Phone Numbers.
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 Voice Messages: select the voice messages to be sent in response to the event: you can select up to three voice messages
per event (First Message, Second Message and Third Message); click on [...] to browse the list of messages; you can
select a pre-recorded message (see Voice Messages) or record a new one, or open a .wav file on the PC.

 SMS Tel. Numbers: select the numbers to which an SMS is to be sent.

 The phone numbers are those selected in the line SMS Phone Numbers.

 SMS Text: enter the text to be sent when the event occurs (up to 70 characters).

Central Station Calls

The following options is related to digital event reporting to the central station.

Periodic Call

 Periodic Test Transmission Interval: set the interval (Days and Hours) between two Periodic Test Transmissions
events. Range: 0 to 365 days and 0 to 23 hours.

 Periodic Test Transmission First Send: set the date and time of the first Periodic Test Transmission event.
The 24hr/12hr button allows you to select the time display format: 12 hour or 24 hour.
The Now button sets the PC's current time.

SIA

 Date/Time on SIA packet: if enabled, the SIA packet will include the date and time.

Phone Number Use

This table specifies which numbers in the Phonebook are to be used for sending digital messages, when Channel Type is set
to CID: Over GSM: up to 8 numbers can be set.

 When you select Channel Type, CID/SIA: over Data Network, the events are transmitted to the IP receivers indicated
in the IP Receivers page.

Events—Actions

This table specifies, for each event handled by the communicator, the digital messages to send to the numbers specified in the
table Phone Number Use.

 Label: this column lists the events for which a digital message is to be sent.
 Customer code: enter the user code (4 hex characters).

 You can set a different Customer code for each Input Event, or a single Customer code for all other events.
DO NOT use the character “A” for Contact ID.

 Contact ID Identifier: enter the Contact ID the communicator is to send for the event.

 The communicator also sends the qualifier 1 when the event occurs and the qualifier 3 when it terminates, as required by the
Contact ID protocol.

 Event SIA Identifier: enter the SIA code the communicator is to send when the event OCCURS.
 Restore SIA Identifier: enter the SIA code the communicator is to send when the event TERMINATES.
 Channel Type: select CID: Over GSM to send the event with the Contact ID protocol using a voice call on GSM; select

CID/SIA: over Data to send the event with the Contact ID or SIA protocol on the cellular network (the protocol will be the
one selected in the Communication Protocol option in the Options page).

 Event Enabled: select Disabled to NOT send the event; select Send Activation to send ONLY the event's occurrence;
select Send Restoral to send ONLY the event's restoral; select Send Activation and Restoral to send both.
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Telephone Numbers: select the numbers to which the event is to send the digital message, when you have selected Channel
Type, CID: Over GSM.

 When you select Channel Type, CID/SIA: over Data Network, the events are transmitted to the IP receivers indicated
in the IP Receivers page.
The phone numbers are those selected in the Phone Number Use table.

CID/SIA Converter

If the communicator detects that the panel connected to the LI terminals is dialing a number from the Phonebook with the option
CID/SIA Event Conversion e nabled, it converts t he panel's Co ntact I D o r SIA message int o a  vo ice or SMS message,
as indicated in this page.

Phone Number Use

This table specifies which numbers in the  Phonebook are to b e used for se nding SMS ( SMS Phone Numbers) and voice
messages (Voice Dialer Phone Numbers): you can choose up to 8 numbers for each option.

Events—Actions

 Label: this column lists the events for which a voice or SMS message is to be sent.
 Contact ID Identifier: set whether the event to be converted is an Activation or Restore; set the type of event 

(e.g. 130 - Burglary); select the partition of the event; select the zone of the event.

 This option is considered only if Contact ID has been selected as Communication Protocol in the Options page.

 Event SIA Identifier: enter the SIA event identifier to be converted.

 This option is considered only if SIA has been selected as Communication Protocol in the Options page.

 SMS Tel. Numbers: select the numbers to which an SMS must be sent.

 The phone numbers are those selected in the line SMS Phone Numbers.

 SMS Text: enter the message to be sent when the event occurs (up to 70 characters).
 Voice Messages: select the voice messages to be sent when the event occurs: you can select up to three voice messages

for each event (First Message, Second Message and Third Message); click on [...] to browse the list of messages; you
can select a pre-recorded message (see Voice Messages) or record a new one, or open a .wav file on the PC.

 Telephone Numbers: select the numbers to which the event is to send a voice message.

 The phone numbers are those selected in the line Voice Dialer Phone Numbers.
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IP Receivers

This page sets the options relating to the communicator's connection with Sur-Gard System IP receivers I, II, III, IV and 5.

 Given possible delays in transmission on the cellular data network, depending on the activity of the network operator,
we recommend programming as high as possible the number of call attempts on the panel, and also setting a backup phone
number which will send the alarms via GSM rather than cellular data network.

 The communicator does NOT support the shuntdown command by Sur-Gard receivers.

Receiver Options

 Fibro Account #: enter the account number for the Fibro protocol: when transmitting events to IP receivers, the Contact ID
and SIA are wrapped in the Fibro protocol and this requires its own account number to identify the account which is sending
the events.
Contact your central station for details. Factory setting: 0000FFFFFF.

 You must assign a different account number to each communicator which transmits events to a given receiver.

 DNIS: the communicator transmits the DNIS code inside the Fibro packet to enable the receiver to identify the device (hex
numbers from 00000 to FFFFF).

 Encryption Enabled: if e nabled t he communicator e ncrypts a ll co mmunications wit h t he I P rece ivers to  in crease th e
security of its data transmissions.

 Hold ACK in memory timeout: sets how long an IP receiver ACK (acknowledge) is kept in memory. Within this period of
time, if the communicator detects that the panel is at tempting again to send a message to the IP receiver and the latter
acknowledges it (ACK), the communicator confirms reception directly to the panel with a kiss-off signal, without sending the
message again to the IP receiver. If set to 0 (factory setting) ACK's are not held in memory. It is worth setting a value greater
than 0 when the panel attempts to transmit each call only once and does not manage to receive the ACK from the IP receiver
on time. Range: 0 to 15 minutes. Factory setting: 0.

Receiver 1

 Receiver functionality mode: select Primary (receiver 1 is enabled) or Not Used (receiver 1 is disab led, th e
programming of receiver 2 will be ignored, CID/SIA event transmission is disabled).

 Cellular Receiver 1 Address: enter the receiver's IP address. The address can be entered in the numeric format 
(e.g. 192.168.0.101) or host and domain format (Fully Qualified Domain Name, e.g., host_name.domain_name.com).

 Receiver 1 Remote Port: enter the UDP port receiver 1 is listening to. Range: 1 to 65535. Factory setting: 3061.
 Receiver 1 Local Port: for each receiver, the communicator uses a different UDP port. Range: 0 to 65535. If the local port is

0, the communicator uses a random port number in the range 1-65535. Factory setting: 3060 (3065 for receiver 2).
 Main Receiver APN: enter the Access Point name. This is generally supplied by the cellular network operator.

 Make sure the APN is correct for access to the cellular data network, otherwise certain functions may be limited (contact your
phone operator for details).

 Main Receiver User Name: some operators require communication authentication; enter the user name in this f ield if
necessary.

 Main Receiver Password: some ope rators re quire communication authentication; enter t he pa ssword in this f ield if
necessary.

 Supervision 1 Enabled: if enabled, the communicator supervises communications with the receiver.

 The supervision messages are not sent during voice calls (on GSM). 
4005 Series 49



 Supervision Time 1: set the supervision time. Range: 60 to 65535 s, in 1 s steps.

 In order to ensure conformity with EN 50136-2 supervision must be enabled and the Supervision Time must be no more than
3 minutes.

Receiver 2

The options for Receiver 2 are the same as those for Receiver 1, except for the differences described below.

 If Receiver functionality mode for receiver 1 is Not Used, you can NOT set the options for receiver 2: transmission of CID/
SIA events to the central station is disabled.

 Receiver functionality mode: if Receiver functionality mode for receiver 1 is Primary, receiver 2 may be:
 Not Used, receiver 2 is disabled, the communicator sends the CID/SIA to receiver 1 only (this mode is called “single mode”);
 Backup, the communicator sends the CID/SIA messages to receiver 1 and, should it not be operational or reachable, sends

them to receiver 2 (this mode is called “Main + Backup”);
 Redundant, the communicator sends the CID/SIA to both receiver 1 a nd receiver 2 s imultaneously and s ends the ACK

(confirmation of reception) to the panel only if both receivers confirm reception (this mode is called “Redundant”).

Voice Messages 

This page enables you to record and play back voice messages: refer to “SMS/Voice Calls” on page 46, for how to associate
messages to events. 

The voice messages can be recorded with a microphone connected to the PC, you can load pre-recorded messages from the PC
(hard disk,  LAN, USB key , et c.) or yo u can import voice messages from another co mmunicator, as des cribed in  paragraph
“Programming/Audio Import/Export” on page 38”.

 The Console can import all type of audio files in the WAVE format (.WAV).

 Play button: press this button to play back a voice message.

 Record button: press this button to start recording a new voice message.

 Stop button: press this button to stop playing back or recording the current voice message.

 Pause button: press this button to pause playing back or recording the current voice message.

 Clear button: press this button to delete a voice message saved in the communicator.

 Open button: press this button to load a voice message from a PC resource (hard disk, LAN, etc.).

 Save button: press this button to save a voice message to a PC resource (hard disk, LAN, etc.).

 While a message is being recorded, a progress bar indicates the duration so far.
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PSTN/PTM

This p age relates t o t he PSTN  lin e a nd the PTM function (Pan el Trans mission Monitoring). T he PTM f unction ena bles the
communicator to forward calls on the GSM channel if communications between the panel and the receiver on the PSTN line fail.

 After 5 minutes of use of the GSM line, the communicator will start using the PSTN line again for forwarding panel calls.

The PTM function considers communication to have failed when:

 it does not detect dialing, if the Check Dialing option is enabled (it checks that a number is actually dialled);
 it does not detect the kiss-off (the signal sent from the receiver when a communication terminates successfully).

If the PTM All Numbers option is enabled, PTM is executed when the panel dials any number, otherwise it only monitors the
dialling of numbers which have the PTM option enabled in the Phonebook.

Calls are forwarded on the GSM channel when the PTM Max Errors Before Takeover setting is reached.

Primary Path
 Primary Communication Path: i f you set PSTN, the communicator uses the PSTN line a s its primary channel and

switches to GSM only whe n the PSTN f ails or when t he PTM function trips;  if  you select GSM, the communicator uses
ONLY GSM.

Timeouts
 LE Failure Timeout (sec): enter a time (10 to 3600 seconds) for which the phone line on the LE terminals can be absent

before the PSTN Fault event occurs.

 If any phone devices are connected to the LI terminals, this time may increase up to a maximum of approx. 60 s.

 LE Restore Timeout (sec): enter a time (10 to 3600 seconds) for which the phone line on t he LE terminals must be
present before the PSTN Fault Restore event occurs.

 To ensure conformity with EN 50136-2, the LE Restore Timeout (sec) option should not be modified. Factory setting: 10 s.

PTM
 PTM Max Errors Before Takeover: the communicator switches to GSM when it detects this number of failed attempts.

Range: 1 to 4, 0 disables the option. Factory setting: 0 (disabled).
 PTM All Numbers: if enabled, PTM is executed when the panel dials any number, otherwise it only monitors the dialling

of numbers which have the PTM option enabled in the Phonebook.

 The PTM Max Errors Before Takeover option must be non-zero before you can modify the PTM All Numbers setting.

 Check Dialing: if enabled, the communicator considers a off-hook followed by a on-hook without any number being dialled
by the device connected to the LI terminals to be a failure. Factory setting: disabled.

 The PTM Max Errors Before Takeover option must be non-zero before you can modify the Check Dialing option.

Generic
 Dialing Prefix: when the communicator detects a number being dialled with the prefix in this setting, it sends the call to the

GSM channel, to the phone number without the digits indicated in this option, even if the PSTN in available. Factory setting:
9999.
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Event Log

The Event Log page displays the events logged by the communicator.

The communicator can save up to 2048 events: when the buffer is full, each new event overwrites the oldest, which is thus lost. 

Each event indicates the date and time at which it occurred.

Symbols on the Event Buffer bar

 Click on this icon to load the new events the next time a Global Upload or Communicate Tags is run.

 Click on this icon to cancel the selection of events in the event buffer.

 Click on this icon to open a window for saving an .XML file of the events loaded in the Event Log page.

 The .XML file can be viewed with Excel or a compatible application.

 Click on this icon to display the events in relation to the criteria indicated in the Events In and With Text options.

 Events In: select the events you wish to view: All Events, Today, Last 7 Days, Last 14 Days, Last 30 Days, Last
Year or Custom.
Select Custom to set a specific period of time.

 With Text: only events containing the specified text will display.

Firmware Update

 Only the level 4 installer, when enabled by the installer, can run firmware updates.

The Firmware Update page updates the communicator's firmware, both locally (PC-Link or USB) and remotely (cellular data
network). 
Click on Select Firmware File to select the update file.
If the firmware update does not terminate successfully, the communicator will continue using the old version.

The name of the firmware file has the format FWxxyyzz.bin where:
 FW identifies the file as firmware;
 xx is the higher revision number;
 yy is the lower revision number;
 zz is the test revision number;

.bin is the extension for a binary file.
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Status

This page gives a range of information about the communicator, as indicated below.

When y ou se lect t he Status page, t he Co nsole automatically d isplays t he Communicate Tags windo w to es tablish
communications with the communicator; once it is, the Status page updates every 5 seconds

Device Information

The Device Details box shows information which may be requested by technical assistance.

The Network Status box shows information relating to the GSM network, as given below.

 GSM Provider Name: indicates the name of the mobile phone operator.
 GSM Signal Strength: gives the strength of the GSM signal.
 Cellular: the type of network.
 Best Operator: when no SIM is in the communicator, it shows the mobile operator with the best signal strength.
 Last Credit Received: shows the SIM's credit updated to the last request made with the Request for PayAsYouGo

Balance button or as programmed in the Pay As You Go Balance section of Options page.
 Last Credit Date/Time: shows the date and time of the last credit update.
 Request for PayAsYouGo Balance: press this button to display the residual credit of the communicator's SIM card.

 This function is only available with the local connection (PC-LINK or USB) and if the Pay As You Go Balance options in the
Options page have been set properly.

GSM

Main board

LED Normal operation Malfunction

GSM ready Green: the GSM net work is ava ilable and th e
communicator is operating.

Red: the communicator is not yet ready.

Radio ON Green: the radio module is on. Red: the radio module is off.
SIM OK Green: the SIM is properly functioning. Red: there is a problem with the SIM card: SIM not

present, SIM expired, PIN enabled on SIM.
Carrier OK Green: the operator is connected. Red: the operator has not been connected.
Signal OK Green: the  signal st rength is  abov e th e re quired

minimum.
Red: signal too low or no signal.

LED Normal operation Malfunction

Power OK Green: main powe r ( +V te rminal) is abo ve th e
minimum threshold.

Red: main power (+V terminal) is less than 10.7 V.

Battery OK Green: t he c ommunicator's battery (if  any ) is
charged.

Red: the battery voltage is less than 3.4 V.

PSTN OK Green: the PSTN line (c onnected to th e
communicator's LE terminals) is available.

Red: the voltage on the LE terminals is less than
2.5 V.

No Jamming Green: no jamming. Red: the communicator's function is being jammed
(sabotage).

Antenna OK Green: th e ant enna ANT5-02 is c onnected an d
working properly.

Red: the antenna ANT5-02 is connected but NOT
working OK (wire cut).
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Call
 Incoming Call: orange—the communicator is receiving a call.
 Call In Progress: green—the communicator is engaged with a call.
 Outgoing Call: orange—the communicator is making a call.
 Radio Initializing: green—the radio is initialising.
 Passthrough: green—the communicator is in pass-through mode.

Receiver 1
 Status: 
 grey: the options for receiver 1 have NOT been programmed;
 orange: receiver 1 is connected but NOT initialised;
 red: the options for receiver 1 have been programmed but the receiver is not initialised, has disconnected due to a problem,

is unable to connect or initialisation has failed;
 green: receiver 1 is initialised and connected.
 Cellular Connection: green—the communicator is transmitting messages to receiver 1.

Receiver 2
 Status: as for Receiver 1 but for receiver 2.
 Cellular Connection: green—the communicator is transmitting messages to receiver 2.
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APPENDIX

Conformity with EN 50136-2:2013

To be compliant with EN50136-2:2013, the communicator must be configured and connected to a burglary alarm panel in one of
the two following ways (A and B) only:

A) PSTN connection (the panel must monitor the receiver's response directly via PSTN)

 PSTN: The communicator's LI terminals are connected to the panel's external phone line terminals.
 Terminal T4, configured as the Tamper output, is connected to the panel input (models with plastic housing only).
 Terminal T5, configured as the GSM Fault output, is connected to the panel input. 
 Terminal T3 configured as I nterconnection Present, is c onnected to the panel signal, to report that the pane l is present,

or phone line present signal.
 Terminal T6, configured as IP Receiver Communications Failure, is connected to the panel's Jamming input.

 In the communicator's programming page IP Receivers—specify an IP receiver.

B) no PSTN 

 Terminal T4, configured as the Tamper + Jamming output, is connected to the panel input (models with plastic housing only). 
 Terminal T5, configured as the GSM Fault output, is connected to the panel input. 
 Terminal T1, configured as the Alarm/Tamper input, is connected to the panel's intrusion alarm/tamper output. 

 Input 1 Event is used to send the intrusion alarm code. 

 Terminal T2, configured as an input, is connected to the panel's fault output. 

 Input 2 Event is used to send the fault code.

 Terminal T6, configured as IP Receiver Communications Failure, is connected to the panel's input. 
 Terminal T3 configured as Interconnection Present, is connected to the panel signal, to report that the panel is present.
 The communicator's earth terminal must be connected to a panel input, to detect the connection between the panel and the

communicator. 

 In the communicator page Central Station Calls, for the two events Input 1 Event and Input 2 Event, set a Customer
Code and set Channel Type to CID/SIA: over Data Network. In the IP Receivers page, specify an IP receiver.
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See the following tables.

 The following must be configured: an event for sending the Alarm/Tamper Contact ID, in case of activation of input 1, and an
event for sending the Fault Contact ID in case of activation of input 2.

Communicator Panel

LI  LE

T1: PSTN Fault output
T2: No Cellular Network output

Fa
ct

or
y 

se
tti

ng

T3: Interconnection Present  LE Detection output

T4: Tamper output  Communicator Tamper input

T5: GSM Fault output  GSM Fault input

T6: IP Receiver Communications Failure output  IP Receiver Communications Failure input

Table 12 – Connection scheme A: simulated PSTN.

Communicator Panel

Fa
ct

or
y 

se
tti

ng

T1: Alarm/Tamper input  Alarm/Tamper output

T2: Fault input  Fault output

T3: Interconnection Present  Interconnection Present input

T4: Tamper + Jamming output  Communicator Tamper input

T5: GSM Fault output  GSM Fault input

T6: IP Receiver Communications Failure output  IP Receiver Communications Failure input

Earth terminal  Earth terminal

Table 13 – Connection scheme B: without simulated PSTN.
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Operations with the USB key

 The USB can ONLY be used if the communicator is in USB Host mode (see “Description of jumpers” on page 8) and the
EN50136 option is disabled (see “Options” on page 41).

The USB key allows you to:
 update the communicator's firmware;
 export/import the communicator's settings;
 export/import the communicator's voice messages;
 export the communicator's event buffer.

When a USB key is inserted into the communicator's USB port, the following folders are created (marked with the symbol ).

Figure 8 – File structure of a USB key used with the communicator.
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SSSSSSSS represents the communicator's serial number (8 hex digits), so that a single USB key can hold data for several different
communicators: each communicator will read/write to its own folder.

When a USB key is inserted into the communicator, the following procedure is executed:

1. Firmware update, if a valid firmware is in folder B_FW;
2. Communicator settings file export, if the file export.txt is in folder B_PROG;
3. Communicator settings file import, if the file import.txt is in folder B_PROG;
4. Communicator voice message export, if the file export.txt is in folder B_AUDIO;
5. Communicator voice message import, if the file import.txt is in folder B_AUDIO;
6. Communicator event buffer export, if the file log.txt is in folder B_LOG;

Firmware Update

This operation updates the communicator's firmware from a USB key.

1. Download the firmware from the site www.dsc.com.

The name of the firmware file has the format FWxxyyzz.bin where:
 FW identifies the file as firmware;
 xx is the higher revision number;
 yy is the lower revision number;
 zz is the test revision number;
 .bin is the extension for a binary file.

 DO NOT rename the firmware file, otherwise the communicator will not recognise it.

2. Copy the firmware into folder B_FW on the USB key.
3. Insert the key into the communicator's USB port.

If the communicator finds an invalid firmware in folder B_FW, the ACT LED will flash slowly and the event Firmware Upgrade
failed - System is logged to the event buffer.

If the communicator finds a valid firmware in folder B_FW, which is also different from its current firmware, it will install it.

 If more than one firmware file is in folder B_FW, the communicator will install the one with the highest revision number.
If folder B_FW contains a firmware which is less recent than the current one installed on the Communicator, it is installed
anyway: firmware updates allow you to install a more recent firmware or restore an older one than currently installed on the
communicator.

At the end of the process the communicator reboots and logs the event FW upgrade done - System.
in the event buffer.

Exporting settings

This operation exports the communicator's settings to a USB key.

1. Create the folder B_PROG on the USB key, if it is not already there.
2. Create a new text file in folder B_PROG and call it export.txt.
3. Insert the USB key into the communicator's USB port.

The communicator will export its settings to B_PROG\SSSSSSSS\EXPORT\eprognnn.bin, where:
 SSSSSSSS is the communicator's serial number;
 eprog is the prefix for a communicator settings file;
 nnn is an index from 001 to 999;
 .bin is the extension for a binary file.

The communicator will search the EXPORT folder for the settings file with the highest index and create a settings file with that index
incremented
58 Universal Cellular Communicator



If the EXPORT folder already has a settings file with index 999, exporting is not possible: the ACT LED will f lash slowly and the
event USB Programming Export Failed - System is logged to the event buffer.

Importing settings

This procedure imports settings from a USB key.

1. Create the folder B_PROG on the USB key, if it is not already there.
2. Create a new text file in folder B_PROG and call it import.txt.
3. Create the folder SSSSSSSS in B_PROG, where SSSSSSSS is the serial number of the communicator to which you wish to

import the settings.
4. Create the folder IMPORT in the SSSSSSSS folder.
5. Copy the settings file to the IMPORT folder: the settings file may be created as described in the export procedure, or on the

Console.
6. Insert the USB key into the USB port of the communicator with the serial number SSSSSSSS.

The communicator will delete the file import.txt and will be programmed as specified in the imported settings file: it will then reboot

 You can import settings files ONLY if the originating communicator has the same installer code. 

 If folder B_PROG contains both the files export.txt and import.txt, the communicator will first export its current settings
(backup) and then import the new ones.

Exporting Voice Messages

This operation exports the communicator's voice messages to a USB key.

1. Create the folder B_AUDIO on the USB key, if it is not already there.
2. Create a new text file in B_AUDIO and call it export.txt.
3. Insert the key into the communicator's USB port.

The communicator will export its voice messages to B_AUDIO\SSSSSSSS\EXPORT\eaudnnn.bin, where:
 SSSSSSSS is the communicator's serial number;
 eaud identifies the file as containing voice messages;
 nnn is an index from 001 to 999;
 .bin is the extension for a binary file.

The communicator will search EXPORT for the voice messages file with the highest index and create a new one with that index
incremented by one; if EXPORT already contains a file with the index 999, it will not export the file: the ACT LED will flash slowly
and the event USB Audio Export Failed - System will be logged to the event buffer.

Importing Voice Messages

This procedure imports voice messages from a USB key.

1. Create the folder B_AUDIO on the USB key, if it is not already there.
2. Create a new text file in B_AUDIO and call it import.txt.
3. Create the folder SSSSSSSS in B_AUDIO, where SSSSSSSS is the serial number of the communicator to which you wish to

import the messages.
4. Create the folder IMPORT in the SSSSSSSS folder.
5. Copy the audio file to the IMPORT fo lder: the audio file may be created as described in t he export procedure, or on the

Console.
6. Insert the USB key into the USB port of the communicator with the serial number SSSSSSSS.

The communicator will delete import.txt and import the voice messages.

 If folder B_AUDIO contains both the files export.txt and import.txt, the communicator will first export its current audio
(backup) and then import the new messages.
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Exporting the Event Buffer

This operation exports the communicator's event buffer to a CSV format text file (Comma Separated Value) on the USB key: the
CSV file can be viewed with Excel and Notepad.

1. Create the folder B_LOG on the USB key, if it is not already there.
2. Create a new text file in B_LOG and call it log.txt.
3. Insert the key into the communicator's USB port.

The communicator will export its event log to B_LOG\SSSSSSSS\EXPORT\elognnn.csv, where:
 SSSSSSSS is the communicator's serial number;
 elog identifies the file as an event buffer;
 nnn is an index from 001 to 999;
 .csv is the file extension.

The communicator will search SSSSSSSS for the log file with the highest index and create a new one with that index incremented
by one; if SSSSSSSS already contains a f ile with the index 999, it will not export the file: the ACT LED will flash slowly and the
event USB Log Export failed - System will be logged to the event buffer.
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Pass-Through

This function allows Power PC1864 panels (PC 1864 4.1 EU, PC 1864 4.2 EU, PC 1864 4.2 ADT Spain, PC 1864 4.5 ADT Spain,
PC 1864 4.5 EU) to be remotely programmed via GPRS using the communicator and the Console updated with the Driver pack
for the GS3125. The communicator must be programmed accordingly before connecting it to the Power PC1864 panel.

 Serial communications via the PC-LINK connector are interrupted when working with the USB key, so the Power panel may
report an error.

Programming the communicator

To program the communicator, see the section “PC PROGRAMMING” on page 35. Proceed as follows, using the Console.

1. Enable Remote Access on the communicator (see Network Settings page).
2. Program a valid Remote Access APN on the communicator (see Network Settings page).

 Make sure the PST jumper is in place.

Connecting the communicator to the Power PC1864 panel

To connect the Power PC1864 panel to the communicator, use a PCLINK-PCLINK cable (see figure 9) connected to the PC-LINK
15 connector on the communicator and the PC-LINK connector on the panel, taking care to insert it in the right orientation.

Figure 9 – Connecting the communicator to the DSC Power panel with the PCLINK-PCLINK cable: A) Communicator; 
B) white wire.

 Connect the PCLINK-PCLINK cable as shown in figure 9, note that the PCLINK-PCLINK connector's white wire must always
be connected to pin 4 of the communicator's and panel's PC-LINK connectors.

Power PC1864 panel procedure

Make the following checks on the Power PC1864 panel.

1. Check section 382 o the panel: option 5 must be set to ON.
2. NO fa ults are permitt ed, the  GREEN LED o n t he pa nel mu st be  ON:  this indic ates that the panel is detecting the

communicator as connected and valid.
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PC procedure

Proceed as follows on the PC before remotely programming with the Console.

1. The PC must have a public IP address and a public port for the Console's incoming connection.
2. The firewall and router must permit connection of the PC's public port to port 51004 on the Console.
3. Make sure it is possible to access the router's public port from another PC to check that the Console can be accessed by the device.

Remote programming with the Console

To program th e panel remotely, yo u must hav e installed the Console on y our PC with  the update drivers (download them fro m the DSC
website).

 In order to obtain support on the Console, you must install the Driver pack for the GS3125.

Before launching the remote connection via G PRS between the communicator and the Con sole, you must send an SM S with a G SM
phone to the communicator, hence you must know the SIM card's phone number. The Console's SMS Message Generator window
contains the information required to create the text of the SMS to be sent to the communicator. To display this window, proceed as follows.

1. Launch the Console on your PC.
2. Create a New Account and select the Panel Type (e.g. PC1864 v4.2EU) e GPRS (3G4005 V1.0) as Connection Type.
3. Enter the requested information and click on Create.
4. Select the page GS / IP and enter the Device ID in the Network Settings page: the communicator's Device ID is on its PCB.
5. For example, c lick on  the Global Upload icon and selec t GPRS as  Connection Type, t he cl ick o n OK: t he SMS

Message Generator window displays.
6. Enter th e Public IP Address of the PC on  which t he Console is ins talled, t o crea te t he SMS, then click  on OK: t he

Console will wait to connect to the communicator.
7. Send the SMS to the communicator with your GSM phone.
8. Once it has received the (valid) SMS, the communicator will launch a remote GPRS connection with the Console.

You can now communicate remotely with the Power PC1864 panel via GPRS.

Figure 10 – Remote programming with the Console A) DSC Power panel; 1) The operator launches a communications session
on the Console via GPRS — the Console displays the information required for the SMS; 2) The operator sends the
SMS with his own phone, using the displayed information; 3) The SMS specifying the Console's public IP and port is
sent to the communicator; 4) The communicator connects to the Console via GPRS; 5) The Console communicates
with the DSC panel (Upload/Download options) via the communicator.
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FCC Compliance Statement

CAUTION: Changes or modifications not expressly approved by Digital
Security Controls could void your authority to use this equipment.
This equipment generates and uses radio frequency energy and if not in-
stalled and used properly, in strict accordance with the manufacturer's in-
structions, may cause interference to radio and television reception. It has
been type tested and found to comply with the limits for Class B device in
accordance with the specifications in Subpart “B” of Part 15 of FCC Rules,
which are designed to provide reasonable protection against such interfer-
ence in any residential installation. However, there is no guarantee that in-
terference will not occur in a particular installation. If this equipment does
cause interference to television or radio reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:
• Re-orient the receiving antenna
• Relocate the alarm control with respect to the receiver
• Move the alarm control away from the receiver
• Connect the alarm control into a different outlet so that alarm control and

receiver are on different circuits.
If necessary, the user should consult the dealer or an experienced radio/tel-
evision technician for additional suggestions. The user may find the follow-
ing booklet prepared by the FCC helpful: “How to Identify and Resolve
Radio/Television Interference Problems”. This booklet is available from the
U.S. Government Printing Office, Washington, D.C. 20402, Stock # 004-
000-00345-4.
IMPORTANT INFORMATION
This equipment complies with Part 68 of the FCC Rules. On the side of this
equipment is a label that contains, among other information, the FCC regis-
tration number and ringer equivalence number (REN) for this equipment. If
requested, this number must be provided to the Telephone Company.
3G4005 Product Identifier US: F53MO00B3G4005
REN:0.0B
USOC Jack:RJ-31X
Telephone Connection Requirements
A plug and jack used to connect this equipment to the premises wiring and
telephone network must comply with the applicable FCC Part 68 rules and
requirements adopted by the ACTA. A compliant telephone cord and mod-
ular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions
for details.
Ringer Equivalence Number (REN)
The REN is used to determine the number of devices that may be connected
to a telephone line. Excessive RENs on a telephone line may result in the
devices not ringing in response to an incoming call.
In most but not all areas, the sum of RENs should not exceed five (5.0). To
be certain of the number of devices that may be connected to a line, as de-
termined by the total RENs, contact the local Telephone Company. For
products approved after July 23, 2001, the REN for this product is part of
the product identifier that has the format. US: AAAEQ##TXXXX. The dig-

its represented by ## are the REN without a decimal point (e.g., 03 is a REN
of 0.3). For earlier products, the REN is separately shown on the label.
Incidence of Harm
If this equipment 3G4005 causes harm to the telephone network, the tele-
phone company will notify you in advance that temporary discontinuance of
service may be required. But if advance notice is not practical, the Tele-
phone Company will notify the customer as soon as possible. Also, you will
be advised of your right to file a complaint with the FCC if you believe it is
necessary.
Changes in Telephone Company Equipment or Facilities
The Telephone Company may make changes in its facilities, equipment, op-
erations or procedures that could affect the operation of the equipment. If
this happens the Telephone Company will provide advance notice in order
for you to make necessary modifications to maintain uninterrupted service.
Equipment Maintenance Facility
If trouble is experienced with this equipment for repair or warranty informa-
tion, please contact the facility indicated below. If the equipment is causing
harm to the telephone network, the Telephone Company may request that
you disconnect the equipment until the problem is solved. This equipment
is of a type that is not intended to be repaired by the end user.
DSC c/o APL Logistics, 757 Douglas Hill Rd., Lithia Springs, GA 30122
Additional Information
Connection to party line service is subject to state tariffs. Contact the state
public utility commission, public service commission or corporation com-
mission for information.
Alarm dialling equipment must be able to seize the telephone line and place
a call in an emergency situation. It must be able to do this even if other
equipment (telephone, answering system, computer modem, etc.) already
has the telephone line in use. To do so, alarm dialling equipment must be
connected to a properly installed RJ-31X jack that is electrically in series
with and ahead of all other equipment attached to the same telephone line.
Proper installation is depicted in the figure below. If you have any questions
concerning these instructions, you should consult your telephone company
or a qualified installer about installing the RJ-31X jack and alarm dialling
equipment for you.

WARNING: To satisfy FCC RF exposure requirements for mobile transmitting devices, a separation distance of 20cm or more must be maintained 
between the antenna of this device and persons during device operation.
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